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Important safety information

Your Turtle Beach™ AudioTron is designed and tested to meet the latest standards for safety of digital music
technology equipment. However, to ensure safe use of this product, it is important that the safety instructions
marked on the product and in the documentation are followed. Always follow these instructions to help guard
against personal injury and damage to your product:

Read and follow all instructions marked on the product and in the documentation before you operate your
system. Retain all safety and operating instructions for future use. Do not use this product near water or a
heat source such as a radiator. Set up the system on a stable work surface. The product should be
operated only from the type of power source indicated on the rating label.

Openings in the product case are provided for ventilation. Do not block or cover these openings. Make sure
you provide adequate space, at least 6 inches (15 cm), around the system for ventilation when you set up
your work area. Never insert objects of any kind into the ventilation openings.

This product is equipped with a three-conductor power cord to make sure that the product is properly
grounded when in use. The plug on this cord fits only into a grounding-type outlet. This is a safety feature. If
you are unable to insert the plug into an outlet, contact an electrician to install the appropriate outlet. If you
use an extension cord with this product, make sure that the total ampere rating on the products plugged into
the extension cord does not exceed the extension cord ampere rating. Do not walk on the power cord or
allow anything to rest on it.

Do not spill anything on the product. The best way to avoid spills is to avoid eating and drinking near the
product. To avoid electrical shock, always unplug all cables from product before cleaning the product.

When the product is turned off, a small amount of electrical current still flows through it. The power cord
should be unplugged from the wall outlet when the device is not used for extended periods of time.

This equipment contains no user serviceable parts. Please refer all servicing to trained, qualified service
personnel.

Unplug the product from the wall outlet and refer servicing to qualified personnel if: (1.) The power cord or
plug is damaged. (2.) Liquid has been spilled into the product. (3.) The product does not operate properly
when the operating instructions are followed. (4.) The product was dropped or the cabinet is damaged. (5.)
The product performance changes.

Caution

Do not use this product in areas classified as hazardous locations. Such areas include patient care areas of
medical and dental facilities, oxygen-laden environments, or industrial facilities.

To reduce the risk of fire, use only No. 26 AWG or larger telecommunications line cord.

Replace fuse only with a 5 x 20mm Slo-Blo® UL/CSA Cartridge Type Fuse matching the original equipment
specifications.
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Contacting Turtle Beach

AudioTron is a product of: Voyetra Turtle Beach, Inc. 5 Odell Plaza, Yonkers, NY 10701 USA

Technical Support: Tel: (914) 966-2150 Fax: (914) 966-1093
Main: Tel: (914) 966-0600 Fax: (914) 966-1102
Web Sites: www.turtle-beach.com www.Tbeach.com
www.voyetra.com www.voyetra—turtle-beach.com

Technical Support

If trouble is experienced with the operation of AudioTron, first look in the Appendix called “Troubleshooting
Tips” or visit our on-line knowledge base.

Web-based technical support

The Turtle Beach web site provides AudioTron Firmware Updates, Frequently Asked Questions (FAQ) and a
comprehensive knowledge base that includes the latest product information and troubleshooting tips.

AudioTron FAQ and Knowledge Base: http://www.turtle-beach.com/wb/audiotron/fag.htm

The Knowledge Base is in the Sales & Support area of our web site.

1. Go to the Turtle Beach web site (www.turtle-beach.com) and click on “Sales & Support”, then “Knowledge
Base”.

2. Scroll down to the "A" section and click on “AudioTron”. This will bring up the list of articles.

AudioTron Firmware & Software Updates: http://www.turtle-beach.com/wb/audiotron/download.htm

The Files & Drivers area is in the Sales & Support area of our web site.

1. Goto Go tothe Turtle Beach web site (www.turtle-beach.com) and click on “Sales & Support”, then “Files &
Drivers”.

2. Scroll down to the "A" section and click on AudioTron. This will bring up the list of files available for
download (including firmware updates and other support files).

Other Technical Support

If you can’t solve the problem by visiting our web support site, contact Turtle Beach Technical Support as follows:
E-mail Tech Support: tech@turtle-beach.com

Many issues can be resolved via email. Please allow at least 48 business hours for a response.

Fax Tech Support: 914-966-1093 Att: Tech Support.

Fax a description of your problem to the above number, and please be sure to include your name, product name,
and product ID/serial number.

Phone Tech Support: (914) 966-2150 M-F, 9 a.m. to 5 p.m. EST (except public holidays)

Please note that all calls will be answered on a first-come, first-served basis. Because we cannot guarantee the
length of time you will be on hold, we highly recommend you only use this option as a last resort. Times are
subject to change without notice.

assistance on network troubleshooting. Please contact the manufacturer of your network hardware for
assistance on getting the network running per the requirements in this manual.

3 Because networks can be set up in so many different ways, Turtle Beach technical support cannot provide

A basic explanation of the networking terminology used in this manual is presented in the Appendix called
“Network Basics”.
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Warranty and End User License

Hardware Warranty

Voyetra Turtle Beach, Inc. ("VTB") warrants to the original end-user purchaser ("Purchaser") that the Turtle Beach AudioTron ("Product") will be free of
defects in materials and workmanship for a period of one (1) year from the date of purchase by Purchaser ("Warranty Period"). If a defect should occur
during the Warranty Period, Purchaser must obtain a Return Merchandise Authorization ("RMA") from VTB. Purchaser will be responsible for all costs
incurred in returning the defective Product to and from an authorized VTB service center, or to the repair facility located at VTB's corporate
headquarters. The RMA number must be clearly indicated on the outside of the package. Packages without an RMA number may be refused by VTB
or its representatives and returned to Sender. The Product must be returned in the original packaging. A copy of the dated proof of purchase must be
included with the defective Product.

In the event of a defect, Purchaser's sole and exclusive remedy, and VTB's sole liability, is expressly limited to the correction of the defect by
adjustment, repair, or replacement of the Product at VTB's sole option and expense. This warranty does not cover, and VTB is not responsible for,
damage caused by shipping, accident, problems with electrical power, misuse, neglect, fire, acts of God, useage not in accordance with product
instructions, unauthorized modification or service of the Product or damage resulting from the use of the Product with hardware, software or other
products not provided or specifically recommended by VTB.

VTB owns all products it has replaced and all parts removed from repaired products. VTB uses new and reconditioned parts made by various
manufacturers in performing warranty repairs and building replacement products. If VTB repairs or replaces a product, the original limited warranty
term is not extended.

VTB's responsibility for malfunctions and defects in the Product is limited to repair and replacement as set forth in this limited warranty statement.
Except as specifically provided herein, there are no other warranties expressed or implied, including, but not limited to, any implied warranties of
merchantability or fitness for a particular purpose. In no event shall VTB be liable for indirect, incidental, consequential, or other damages including
personal injury, lost profits and damages to property arising out of any breach of this warranty or otherwise.

The Product, including operating systems or applications programs, is provided on an "As Is" basis. Some states do not allow the exclusion or
limitation of incidental or consequential damages, so the above exclusion or limitation may not apply to you. This warranty gives you specific legal
rights. You may also have other rights, which vary from state to state.

VTB Software End-User License Agreement

By installing the software included with the Product (“Software”), you acknowledge that you have read, understood and agree to abide by the terms
and conditions of this End-User License Agreement (“Agreement”). If you do not agree with the terms of this Agreement, promptly contact the seller of
this Software to arrange an appropriate remedy.

SOFTWARE LICENSE: This is a legal Agreement between you (either an individual or an entity) and VTB that sets forth the license terms and
conditions for using the enclosed Software and updates of the Software. In this Agreement, the term "Use" means loading the Software into RAM, as
well as installing it onto a hard disk or other storage device.

The Software is owned by VTB and is protected under United States copyright laws as well as international treaty provisions. You must treat the
Software as you would any other copyrighted material. VTB retains title and ownership of the Software. The purchase price for the Product grants you
a non-exclusive license to use one copy of the Software on a single computer. You may make copies of the Software solely for archival purposes. You
may not make copies of any written material accompanying the Software. You may not allow third parties to use the Software by time-sharing,
networking or any other form of multi-user participation. You may not rent, sell, lease, sub-license, time-share or lend the Software to a third party or
otherwise transfer this License without written permission from VTB. You may not decompile, disassemble, reverse-engineer or modify the Software.

This Agreement is effective until terminated by the destruction of the Software — all of the CD-ROMs and/or diskettes — and documentation provided
in this package, together with all copies, tangible or intangible. If you fail to comply with any of the terms and conditions of this Agreement, this License
will be terminated and you will be required to immediately return the Software to VTB— CD-ROMs and/or diskettes — and documentation provided in
this package, together with all back-up copies. The provisions of this Agreement which protect the proprietary rights of VTB will continue in force after
termination.

LIMITED LIABILITY: You assume responsibility for the selection of the Software to achieve your intended results, and for the installation, use and
results obtained from the Software. VTB MAKES NO REPRESENTATIONS OR WARRANTIES WITH REGARD TO THE PRODUCT, SOFTWARE
OR DOCUMENTATION, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.

VTB shall not be liable for errors or omissions contained in the Software or manuals, any interruption of service, loss of business or anticipatory profits
and/or for incidental or consequential damages in connection with the furnishing, performance or use of these materials. The Software and
documentation are sold AS IS.

This Limited Warranty gives you specific legal rights and you may also have other rights that may vary from state to state. Some states do not allow
the limitation or exclusion of implied warranties or of consequential damages, so the above limitations or exclusions may not apply to you. You agree
that this is the complete and exclusive statement of the Agreement between you and VTB which supersedes any proposal or prior agreement, oral or
written, and any other communications between us regarding the subject matter of this Agreement. This Agreement shall be construed, interpreted
and governed by the laws of the State of New York, except the federal laws governing copyrights and registered trademarks. If any provision of this
Agreement is found unenforceable, it will not affect the validity of the balance of this Agreement, which shall remain valid and enforceable according to
its terms.

Page 3



Turtle

www. Turtle-Beach.com . Beach
Table of Contents
[N 0] 1o 2SO RRP PR 1
(@] g1 7= Tox 1] To T U 11 [= 0 === Vo] o 2
TECNNICAI SUPPOIT ...ttt ettt e s bttt e e s b et bt e sbe e e b bt e be e e sk bt e abe e e s bb e e nbe e e nbeeenbne e e 2
Warranty and ENGA USEI LICENSE.......cooi ittt ettt e e e e e e s bbbttt e e e e e e s bbb beeeeaaeeeannbeneeas 3
HAIAWEAIE WAITANTY ...ttt ettt ettt e e e e ookttt e e e e e e e a e b et e e e e e e e o ntbeeeeeae e antbeneeaae e sansbeseeaaeesaansnnneeaaaaan 3
VTB Software ENd-USEr LICENSE AQIEEIMENT.........uuiiiiiieeiiiiiiiiee e e et eeitir et e e e s e st e e teaeeaasatbaeeaaeesssstbareeaeeessasaareeeaeesn 3
Taligelo [BTed o o I ANE (o [To ) N fo] s LU NP PPTUPT PO 6
AudioTron Digital Music System CONfIQUIALIONS .........coii i e e e et e e e e e s e anaeeeeeaeeean 7
LCT= 1] o TS r= Lt =T o PSR 10
[ 1ot - o [T @0 g1 (T | £ PRSP 10
F 0 (o 1o} I o] g J @] o] 1 o] o <O ERU PR 10
YA (] I R o [T L= 41T ] PP UPRRRTN 10
YO Lo Lo I (oL TS T=] (0] oI d (o ToT=To LU =R 11
LoV T o To AN N o 1ol I o] [T TP T PUPPUPPRRTT 12
B ST ] o 2 o o I (o o PSSO PPRRS 12
AUAIOTION'S POWET-UD MESSAGES. ...t e iuteeeeitite ettt ett ettt ekttt e ettt e e bt e e bt e e e s et oo bt e e e bt e e e e ab et e st bt e e aabe e e e sab e e e nabeeeeannnes 13
Installing the AUAIOSTAION CD ....cuiiiiiiiceiieiiee e e e e s s e s ae e e e e e e s st eeeeeeesasssrtneeeeeeesannnrnneees 14
SAMPIE MUSIC FIES ..ttt a e et e bt e oo et e e oo ab et e ek bt e e e s bb et e nab et e ek bt e e anbb e e e nabeeeanbneeeanes 14
AUAIOTION SEIUP ULIILY .ottt oottt e e e e ettt ettt e e e e s b ettt e e e e e aa bbb et e e e e e e s R bee e e e e e e e anbe bbb e e e e e e nsbebeeaeeeeansnbneeeaeaann 14
AudioStation MUSIC JUKEDOX SOTIWEIE ........cc.eiiiiiiii it e s sne e s 14
Installing AudioTron 0N an HPNA NEWOIK .......ccuueiiiiiiieiiiie et e ee e e e e sneeeeeeas 15
[2TS] (o] (I 01U I o =T |1 o 1R PRSP ERRTR 15
Installing AudioTron 0N an Ethernet NEWOIK ...........eeviiiiiiiiiiiiiiee e e e e e s s e e e e e e snrene e 17
Connecting AudioTron to an Ethernet network With @ HUD ..........ooiiiiii i 17
Configuring AudioTron’s NetWOIK SEHINGS ... ..uuuiiiieeiiiiiiiiie e e s e e e e s e r e e e e e s e rreeeees 19
(2T (0TI o]0 I o =T || o TS PR SRPTO 19
ConNecting the AUGIO OULPULS.........uiiiiiieee ettt e e e e e e e e e e e s an bt et e e e e e e s e aanbbeeeeaaeeeaannbbeeeaaaeaas 21
[2TS] (o] (I o1 U I o =T |1 o 1R PRSP 21
Audio TroubleShoOtING PrOCEAUIE ..........eeiiiiiee ettt e e e e e ettt e e e e e e e ntbteeea e e e e eannnnaeeaaaean 22
Playing Your Music Library With AUGIOTION . ....c..coiiiiiiiiiie ettt e e e e e e s e e e e e e e e e e anes 23
Yo gTo IST=] (ST on (o] g T DI o] o U SRPPUPRRRTN 23
Yol aTo o Fo Y oF- Tt 1T o] = YU USUPPUPRRRTN 23
Creating @ GrOUP OF SONQGS....ciii et iiiiiiiiie ettt e e ettt e e e e e e e tb e et eaaeaaantaeeeeaaeaeaanseeeeeeaaaeaasnsseeeaaeeaaannsbeneaaeeasaannns 26
Using the “Favorites” RemMOte CONIOI FEATUIE ..........uuiiiieiiiiiiiiii ettt e e e e e e s e e e e e s e et e e e e e e s e e sneaaees 27
Managing Your Music Library with AUAIOSTAtION ............oiiiiiiiiii e 28
Using the Voyetra AudioStation JUKEDOX SOIWATE.......c.coii i e e 28
Song Tags (Title, Artist, AIDUM, GENIE, BIC.) ....uiiiii ittt e e ettt e e e e e e et e e e e e e e e antbeeeeaaeeeanees 29
Digital MUSIC File FOIMMALS. ... ittt ettt e e e e ettt e e e e e e e abbee e e e e e e eantbeeeeeeeesaannnsseeeaaesaannraneeas 30
(U=l gTo o] 1Y 1) £ PP UPPUPRRRN 31
Front PAn@l RETEIENCE .....coooi ittt e e e e e s bbb e e e e e e e e e anbbeeeeaaeeeaaanes 32
(@01 1o] 0 E-30 1V =T o T PP UPRRRTN 33
REAI PANEl REFEIEINCE ... ittt sb et e e sttt e e s sttt e e s bt e e e s abbeeeessnbeeeeanes 35
ReMOte CONLIOl REFEIENCE ... .. .. ettt e e e e ettt e e e e e e e e snbbeeeeeaaeeaaanes 36
ProduCt SPECITICALIONS .....eeieiiiiiiiee ettt e e e e e sttt e e e e e e e e abbbee e e e e e e s e sanbbeeeaaaaesaannnes 37
PV o] o 1T e To [)q AN I {o 01 o] [=1< o o] i g T I o1 USRS 38
APPENIX B: NEIWOIK BASICS .....eeeiiieiiiiiiiiiiee ettt e ettt e e e e e e e e it e et e e e e e s s abbbe e e e e e e e e annnreneeas 41
OVErVIEW Of HOME NEIWOIKS ... . ee ettt ettt e e e e e e ettt e e e e e e e nebeeeeeea e e e annntbeeeeaeeaaannsbeeeaaaeaeannees 41
[N Yo ¢ =T a2 T T ] o T | PRSP ERR TR T 42
Checking Windows 98 Network settings With “WinipCfg.eXe”........uuiiiii it 44
Appendix C: Network Troubleshooting PrOCEAUIE .........ooi it 45
Using the AUAIOTION SELUP ULITILY .....oeeii ettt e e e e ettt e e e e e s e et e e e e e e e s eannnseeeaaaeeaanneaeeeas 46



FTurtle

4. Beach AudioTron Reference Manual

(@] o1=T ol [0 IS T (=11 o O OO UTTT T OUPPPPPTRIN
Network Test Screen ............co......

Shared Directories Test Screen....
VIEWING the TESE RESUILS ... ...ttt oottt et e e e oo bttt e e e e e e o kbbbt e e e e e e s sbb s e e e e e e e aanbbe e e e e e e e annbbbeeaeeeeannnneeeas

PN o] o 1T Lo [D e B ] g = 1 =T I B = Tod (o ) =PSSOSR
Song Directory TroubleShOOtiNg PrOCEAUIE ...........oiiiiiiiiie ettt e e e e e e e s e e e e e s e etbareeaaeeseannnenes

AudioTron Shared Directories Requirements
Bypassing AudioTron’s Shared DireCtory RESIHCHON ..........eiiiiiiiiiiii ittt e e e e e e e e e e e aanreeeas

Appendix E: Updating AUdIOTION'S FIMMWATIE ........ooiiiiiiiiiie et e ettt e e e et e e e e e e s e aanbeeeeaaaeeeaans
Regulatory Compliance INfOrMIEALION. ........cciiiiiiieiiee e e e e e e e e e e s e e e e e e e e e snnanaeeeees

Page 5



Turtle

www. Turtle-Beach.com #.. Beach

Introducing AudioTron™

Y our Turtle Beach AudioTron represents a new generation of home entertainment device—a
"smart stereo component" that takes full advantage of the power and convenience of home
networking, yet fitsright in with the rest of your home entertainment system.

AudioTron uses a network connection to play digital music files stored on your PC hard drive—so
you don't have to be in front of your PC to enjoy the benefits of adigital music library. Your PC
hard drive can store thousands of songsin digital format, which you can obtain by transferring CDs
to the hard drive or by legally downloading music from the Internet.

Storing music on your PC lets you easily manage your music collection, create custom playlists,
create custom CDs, transfer music to a portable digital player, and select songs without having to
search through a pile of CDs—effectively transforming your PC into a powerful jukebox.

With AudioTron, you can enjoy instant playback of any song at any time, from anywhere in your
home. Best of all, by installing several AudioTrons throughout your home, several users can
simultaneoudly listen to their favorite songs from the same song library—making your entire music
collection accessible to the whole family.

AudioTron features...

= Consolidate your CD collection by transferring thousands of songs from CDsto your PC hard
drivein digital format.

=  Enjoy the PC music library in other parts of your home.

= Easily search for songs by Title, Artist, Album, Genre.

= Listento custom playlists of your favorite songs.

= Remote control provides “favorites’ buttons for instantly playing groups of songs.

= Multiple AudioTrons can be used throughout the home, so several people can listen to different
music from the same library of songs—at the same time.

= Compatible with Ethernet 10/100BaseT and HPNA 2.0 (Phone Line) networking standards.
= Usesthefamiliar “look and feel” of a home stereo component.

= Analog and digital audio outputs provide audiophile quality music playback.
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AudioTron Digital Music System Configurations

An AudioTron digital music system consists of the following key components:

-DSL
- Satellite

...... -> “ |
B A LI i 20r. IO |
: | L g;’:fn:: o AudioTron

- Dial up modem

- Cable Modem 'I = m = H Network
-

One or more AudioTrons connected to powered speakers or stereo system(s).
An HPNA or Ethernet network.
A PC with afairly large hard drive for storing digital music.

Den Bedroom

o\ . Portable
cD w Digital

Player ) -
i)

Y} Powered
J Speakers

AudioTron

* o O30

Music Server (Host)

- Hard Drive stores CD and downloaded music

- Internet connection downloads new songs

- PC jukebox software transfers CD to hard drive
- Transfer hard-drive music to portable player

- AudioTron plays music via network connection

Stereo
System

Living Room

Figure 1 AudioTron uses your PC and a network to distribute music throughout your home.

The above example illustrates an AudioTron digital music system where two AudioTrons are used
for distributing music to the bedroom and living room. In this setup, the PC “Music Server” or
“Host” provides several functions:

The hard drive stores alibrary of digital music filesin MP3, WMA or WAV formats, obtained
by transferring audio CDs to the hard drive with a PC “jukebox” program, such as Voyetra's
AudioStation (included with AudioTron).

An Internet connection lets you download legal music files from music sites on the Internet,
further expanding the music library.

Music can be transferred from the PC to a portable digital audio player for listening to music
while travelling.

If the PC is equipped with a CD-R drive, custom audio CDs may be created from the songsin
the PC music library. The custom CDs can be played in a portable CD player or car CD player
that supports playback of CD-R audio discs.

The music library can also be enjoyed at the PC location in the Den by playing the music on
the PC speakers with a PC jukebox program (e.g. the Voyetra AudioStation program included
with AudioTron.)

The following sections describe several variations of this system, ranging from a basic “single PC
to single AudioTron” setup, to an elaborate “multi-PC to multi-AudioTron” setup.
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Basic Setup

The simplest AudioTron digital music system consists of one PC connected to an AudioTron with
either an HPNA or Ethernet network adapter. In the configuration illustrated below, a PC with an
HPNA or Ethernet interface is connected to the AudioTron. Music is stored on the PC's hard drive
and is available both at the PC and the AudioTron locations.

If thisisthe only PC in the home, it will most likely be used for other tasks while music is playing.
Therefore, it should be fairly robust or applications running on the PC may slow down as the hard
drive transfers song data to AudioTron via the network connection.

PC with PC with
HPNA mterfae Ethernet interface

AudioTron
HPNA Connection

-, E—-O

AudioTron
Ethernet Connection

2:-. I O

phone cable
Ethernet Hub

Ethernet
% Cat-5 cable

HPNA Network Connection Ethernet Network Connection

Ethernet
Cat-5 cable

Figure 2 A basic setup can be achieved with a simple HPNA or Ethernet connection.

Medium Setup

In a more sophisticated setup, the network contains several PCs, each with music files. In the
example below, two PCs provide amusic library of 1700 songs for AudioTron'. Once AudioTron
scans the network, the location of the songs is transparent, so you won't have to switch between
PCs when accessing the music.

1200 songs + 500 songs = 1700 songs
PC with PC with AudioTron
HPNA interface HPNA interface HPNA Connection

[ses=zfer. mummm—-O |

Phone
Wire

Phone Phone

l Jack l Analog Phone Line Jack

Figure 3 AudioTron can access music stored on all of the PCs in your network.

" AudioTron can access a library of more than 30,000 songs, depending on the “tag” data embedded in the
songs, directory structure, and other database information.
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High-performance Setup

In a high-performance digital music system, a dedicated PC with massive hard drive storage (e.g.
60GB or more) is used for storing the music library and isleft on so the music is always accessible.

AudioTron provides all the processing power required to play back digital music—the PC “Music
Server” isonly used for storage and file access. Any reasonably capable PC may be used as amusic
server, aslong as it can be connected to an HPNA or Ethernet network and has enough hard disk
space to store your music library. For example, a 233MHz PC with alarge hard drive would
probably work fine (which might be a good application for an older PC you put aside when you
upgraded to a faster system)

In this example, multiple AudioTrons and multiple PCs (networked via HPNA or Ethernet) can
each play different music at the same time from the music library on the PC Music Server. With the
music library stored in asingle location on the PC Music Server, family members can each play
their favorite digital music whenever and wherever they want.

Music can also be played on the networked PCs with the AudioStation software (or other jukebox
program). The AudioStation software can be controlled by an optional RF Remote Control that
links to the PC serial port viaan RF receiver.

For more information on the Voyetra AudioStation RF Remote Control Unit, please visit the Turtle Beach
web site.

PC with
Ethernet
Connection

PC with
Ethernet
Connection

Dedicated PC
Music Server

Ethernet
Network Hub

Used only for e -
storage of socsiofzes, NN

music library AudioTrons with w
Ethernet Connection i
[Fe25efar, mm O | PC with

Ethernet
Connection

Figure 4 A dedicated PC music server provides optimum performance in a high-end configuration. AudioStation
software can be used to play music on the PCs.
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Getting Started

3 Be sure to Check the Turtle Beach Web Site for AudioTron firmware updates.

Package

Turtle Beach will periodically release new updates for the AudioTron firmware to implement feature
enhancements and operational modifications. Instructions on how to update the firmware may be found in the
Appendix section of this Reference Manual.

Contents

Turtle Beach AudioTron™

AudioTron User's Guide

AC Power cord

IR remote control with AAA batteries

RCA-to-RCA stereo aud

io cable (to connect to your home stereo or powered speakers)

Telephone cable with RJ-11 connectors (for use with HPNA phone line network)

Ethernet Category-5 (“Cat-5") cable with RJ-45 connectors (for use with Ethernet network)

CD containing AudioTron Setup Utility, AudioStation® jukebox, Reference Manual, music files, and more.

AudioTron Options

The following items may be purchased from the Turtle Beach web site (www.turtle-beach.com):

AudioTron Rack Ears

Use these to mount AudioTron in a 19" rack system.

Fiber Optic Cable

Connects AudioTron’s S/PDIF digital optical output to compatible audio equipment.

Powered Speakers

Turtle Beach offers high-quality speaker systems for use with AudioTron.

RCA-to-1/8” Cable

Connects AudioTron’s RCA outputs to speaker systems with 1/8” line input jacks.

System Requirements

One or more networked
PCs.

Recommended Minimum PC System: Pentium 233MHz processor, 64MB
RAM, CD drive with digital audio extraction, 16 bit color video card, Internet
connection and web browser. The PC should have sufficient hard disk space
for storage of your digital music files. (A four-minute song uses approximately 3
to 5 MB of hard disk space in MP3 or WMA compressed format.)

Windows File Sharing.

Supports the following operating systems:

Windows 98/ Windows Me/ Windows NT4.0 Professional sp4 or higher with
Internet Explorer 4.01 or higher/ Windows 2000 Professional.

An HPNA 2.0 or Ethernet
10/100BaseT network
running TCP/IP.

AudioTron includes a phone cable for the HPNA connection and a Cat-5 cable
for the Ethernet connection. AudioTron is compatible with a Class-C network.

Powered speakers or a
stereo system with line
level inputs

AudioTron includes a stereo RCA-to-RCA cable for connecting the analog
audio outputs to powered speakers or a stereo receiver. A fiber optic cable for
the digital audio output may be purchased at the Turtle Beach web site.

A PC “jukebox” program
to convert your CDs to
digital audio files

The AudioStation CD includes Voyetra's AudioStation jukebox software to
perform this function in Windows 98/ Me. AudioTron also operates with jukebox
programs compatible with music files in the MP3, WMA and WAV formats and
ID3 tags in the Version 1.0, 1.1 or 2.3 format.
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AudioTron Setup Procedure

Follow this basic procedure to set up your AudioTron.

Install the sample music files so the proper directories will be configured.

Install the AudioStation CD Install AudioStation if you do not already have a PC jukebox program, or if you would like to use

AudioStation to manage your digital music library.

See "Installing the AudioStation CD" for details

Connect AudioTron to your Make sure your HPNA or Ethernet network is operating properly before setting up AudioTron.

network

Connect AudioTron to your
audio system

Power-on AudioTron

See "Connecting AudioTron to your Network" for details

Use either the analog line outputs or SPDIF digital optical output (for highest audio quality.)

See "Connecting AudioTron to your Audio System" for details.

Turn on the rear panel power switch, wait a few seconds. Press and hold the
standby button. for a few seconds, then release.

See "Powering AudioTron" for details

What happened?
Searches for songs, then Finds Host PC. "No Hosts Found" "Waiting for Network"
displays the main menu Then main menu displays Then main menu displays then displays
with a song title "No Songs Found" "No songs found" "No Hosts found"
See "Song Directory
Press Play Troubleshooting See "Network Troubleshooting Procedure”
Procedure"
What happened?
Song plays. No sound.
AudioTron is ready. See "Audio
See "Playing your PC Troubleshooting
Digital Music Llbrary" Procedure"
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Powering AudioTron

AudioTron has two power switches:

= Rear panel power switch: Turns on the main AC power to the unit.

= Front panel Standby button: Places AudioTron in a*“power-down” state whereby the main

power is still on, but the unitisin a“partial shutdown” mode that retains its temporary settings.

To power-on AudioTron...

1.

Turn on the rear panel AC switch. Wait a few seconds, then press and hold the front panel Standby button
for a few seconds.

If AudioTron is properly connected to the network, it will search the network for PC hosts with song files.
After finding the PC hosts, it scans for songs and catalogs the song names in its internal memory so they
can be quickly accessed.

Once AudioTron is powered on, the rear panel power switch should be left on and the unit should
be turned on and off with the Standby button. Turning AudioTron on and off with the Standby
button avoids the network search process initiated by the “power on” sequence and retains
AudioTron’s temporary settings, so it's ready to play music

If AudioTron won't power on...

v
v
v

°|

Check that the rear panel power switchis on.
Make sure to press and hold the Standby button for afew seconds.

Check that the power cord is seated properly in the AudioTron’s rear panel receptacle and in
the AC wall outlet.

Check the AC outlet power by installing another known working electrical appliance (like a
lamp) into the same outlet to seeif it operates.

Check AudioTron’s fuse (see the section called “Rear Panel Reference”)

If you will not be using AudioTron for an extended period of time, the AC power
switch on the rear panel should be turned off.

“Re-setting” AudioTron

AudioTron may be “reset” by turning the rear panel power switch off and on, waiting a few
seconds, then pressing the Standby button. This would be necessary, for example, if AudioTronis
behaving erratically, or if you wish to re-scan the network because a new PC has been added.

=

The network song search initiated by resetting AudioTron can be cancelled by pressing the
“Stop” button. Songs can then be scanned with the AudioTron “Search for New Music”
feature in the Options menu.
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AudioTron’s Power-Up Messages

One or more of the following messages may appear while AudioTron is powering on:

Version 1.1 — Enet DHCP

Indicates the firmware version number and the type of network connection
detected. For details on how to upgrade the firmware version, see the
Appendix “Updating AudioTron’s Firmware”.

In this example, AudioTron has detected firmware version 1.1, an Ethernet
network and a DHCP server. If you're using HPNA, the display would
instead indicate HPNA DCHP. Be sure to check that the displayed
network corresponds to the type of network you're using. For instance, if
you connected an Ethernet cable and AudioTron’s display indicates
HPNA, check the network cable connection to AudioTron and check the
network for proper operation.

Looking for Hosts
— xx% Complete

Indicates that AudioTron has found the network connection and is
searching for PC’s on the network.

Found x Hosts

Indicates the number of PCs or other devices with IP addresses detected
on the network.

Searching for Music
Found xxx Songs

Indicates the number of songs found on the PC’s in the network. After the
song search is completed, the first song title in the library is displayed
under the main menu and AudioTron is ready to play music.

Waiting for network: xx secs

Indicates that AudioTron is trying to connect to the network. If a network
connection can’t be established after 120 seconds, it stops searching and
displays “No Hosts Found” followed by “No Song Titles Found”.

No Hosts Found

Indicates that no PCs were found on the network.

No Song Titles Found
(Displayed under main menu)

Indicates that no songs were found on the host, or that no host was found.
Check for the proper directory names and shares, as described in the
section “AudioTron Shared Directories Requirements”.

If AudioTron displays “No Hosts Found” when powered on...

v" Make sure your PC is powered on. If it is, then make sure the “power save” feature is not
turning off the PC and/or hard drive after a period of non-use. The Windows Control Panel
“Power Management” icon launches a dialog box that will let you set the power-save features.

v" Reconnect the network cable into AudioTron’s rear panel to make sureit “clicks’ when

inserted.

v' Try another network cable to make sure the problem is not due to a defective cable.

v' Check the “Network Troubleshooting Procedure” in the Appendix.
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Installing the AudioStation CD

The CD included with AudioTron contains the following components that make it easier to set up
your digital music system. To install the CD, placeit in the CD ROM tray and run the Setup.exe
program by clicking Start > Run = Browse. Follow the on-screen installation promptsto

complete the installation.

Sample Music Files

AudioTron requires that the song filesin your digital music library residein “shared” directories
with specific names. For details on how AudioTron uses “shared directories’ to access the music
library, see the section called “ AudioTron Shared Directories Requirements” in the Appendix

section of this manual.

The AudioStation CD lets you install sample music filesin directories with the proper names so
you can easily move your other music files into these directories after you' ve set up your system.
Theinstallation, however, cannot set up the directories as “ shared” if they are not already set that
way. To do this, you'll have to set the share manually, as described in the section called
“AudioTron Shared Directories Requirements”. Before doing this, you should first run the
AudioTron Setup Utility to seeif the directories are already configured properly.

AudioTron Setup Utility

The AudioTron Setup Utility helps you set up your
AudioTron network configuration by:

Confirming that music files are located in directories properly
configured for AudioTron access.

Displaying “addresses” of PC’s and AudioTrons connected to
your network.

The utility is run from a menu item on the AudioStation
CD install screen. For instructions on how to operate the
Setup Utility, see the Appendix “Network
Troubleshooting Procedure”.

AudioStation Music Jukebox Software

k] e bl L

Figure 5 The AudioTron Setup Utility lets you

examine network and drive settings.

The AudioStation jukebox program lets you:

Ausiagialion

Play audio CDs on your PC’s CD ROM drive.

Transfer songs from a CD to the PC hard drive in
WAV, MP3 or WMA formats (using Windows 98/
98SE or Me) for use with AudioTron.

Edit and obtain track tags (CD title, artist, track
names, etc.) from the CDDB™ database using an
Internet connection.

Create custom playlists of music tracks for use with

AudioTron.

AudioStation includes comprehensive online help.
Additional instructions may be found in the
section “Managing Your Music Library with
AudioStation”.
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Installing AudioTron on an HPNA Network

This section assumes you have an HPNA 2.0 network running. If you don't have a network installed,
you'll need to install one before installing AudioTron. Please follow the instructions included with your
network installation kit for details.

Because networks can be set up in so many different ways, Turtle Beach technical support cannot
provide assistance on network troubleshooting. Please contact the manufacturer of your network
hardware for assistance on getting the network running per the requirements in this manual.

If you experience any problems setting up AudioTron with your configured network, please see if the
issue is addressed in the “Network Troubleshooting Procedure”, “Troubleshooting Tips” or “Network
Basics” sections in this manual or in the FAQ section of the Turtle Beach web site.

Before you begin...

VoIt your PC has a separate modem
and HPNA Network Interface... For
optimum HPNA network performance,
the modem and HPNA cards should be
connected to the phone jack with
separate cables and a splitter.

PC with
Modem and
HPNA interface

phone cable

. Phone
Splitter

2 you have more than one phone
line... Make sure AudioTron is
connected to the same phone line as
your HPNA network. To check this,
unplug the AudioTron and PC from the
phone jacks, then plug a phone into the Figure 7 To optimize network performance, connect the PC
jack used to connect AudioTron and modem and HPNA card to the phone jack with two wires by
another phone into the jack used to using a splitter.
connect the HPNA interface on your
PC. If you can't talk between the two phones, then the jacks are connected to different phone
lines and there will be no HPNA network communication between the PC and AudioTron.

phone cable
to HPNA NIC

v’ If you have DSL service... Typically, when aDSL modem is installed, the phone company
also installs phone line filters which could interfere with your HPNA network. Be sure the
filter is not in line with the phone wire connected to the PC's HPNA card or to the AudioTron
HPNA connector. See your DSL manual for details on the line filter, if oneisinstalled.

v’ If you have a digital phone system... Some multi-line phone systems use a digital
transmission system on standard phone lines. These types of phone lines are not compatible
with AudioTron or with HPNA networks. Do not connect adigital phone line to AudioTron or
your HPNA network card, as this may damage the units.

v Do not connect a telephone line filter between AudioTron’s HPNA jack and the phone
jack... Transient surge protection is built into the AudioTron phone jack, so an external filter
is not necessary.
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To connect AudioTron to an HPNA Network...

1. Onthe AudioTron rear panel, locate the HPNA interface with two RJ-11 modular phone jacks labeled
PHONE and LINE. The jack labeled LINE is for connection to the HPNA network, while the jack labeled
PHONE is a 'pass-through'’ for connection to a telephone or answering machine.

2. Insert the phone cable (included with your AudioTron) into the LINE connector. Insert the other end into
your phone jack.

3. Ifyou had a phone connected to the phone jack, you can insert the phone line into the connector labeled
PHONE. This allows you to connect both AudioTron and a telephone to a single phone jack on the wall of
the room where you listen to your AudioTron.

4. Proceed to the section called “Configuring AudioTron’s Network Settings”.

Figure 8 Connect the AudioTron LINE jack to the HPNA network using the supplied RJ-11 phone cable.

PC with PC with
HPNA interface HPNA interface
) Stereo Phone
System
RCA or
L] Optical
audio cable

2. m—-O |

AudioTron
HPNA Connection

[Tosms

Phone Phone
Wire Wire
Phone [ Phone

@J Analog Phone Line  Pug |

Figure 9 In a multi-PC HPNA network, each device in the network can be connected directly to the phone line.
The normal operation of your telephone is not interrupted by the network activity.
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Installing AudioTron on an Ethernet network

=

This section assumes you have an Ethernet 10BaseT (or 10/100BaseT) network running. If you don't have a
network installed, you'll need to install one before installing AudioTron. Please follow the instructions included
with your network installation kit for details.

Because networks can be set up in so many different ways, Turtle Beach technical support cannot provide
assistance on network troubleshooting. Please contact the manufacturer of your network hardware for
assistance on getting the network running per the requirements in this manual.

If you experience any problems setting up AudioTron with your configured network, please see if the issue is
addressed in the “Network Troubleshooting Procedure”, “Troubleshooting Tips” or “Network Basics” sections
in this manual or in the FAQ section of the Turtle Beach web site.

Connecting AudioTron to an Ethernet network with a Hub

=

When connecting Ethernet devices together, you' Il need an Ethernet “Hub”, which distributes the
Ethernet signal between multiple devices and controls the network “traffic”. There are many types
of hubs available, and some have enhanced features, such as built-in switches that intelligently
route data in the network to optimize transfer speeds.

PC with
Ethernet interface

PC with
Ethernet interface

AudioTron
Ethernet Connection

Eth t Cat 5 Cabl
ernet Ca able I 220 e}

Ethernet
Network Hub

Figure 10 Connecting PCs and AudioTrons to an Ethernet network requires an Ethernet Hub.

Connecting AudioTron to a PC with
single PC via Ethernet Ethernet

If you're connecting the AudioTron
directly to an Ethernet-equipped PC,
you'll need either a hub or a special
Ethernet “ cross-over cable” (whichis
not the same as the standard Ethernet
cable included with your AudioTron.)

AudioTron
net Connection
5. IO

Since abasic hub is not expensive and Ethernet Ethemet
« » . Cat-5 cable A—— Cat-5 cable
the “crossover” cable may be difficult
tofind, itis S.UQQeSted_ that a hub b_e Figure 11 Connecting a single PC to AudioTron also requires an
used for making the direct connection Ethernet hub.
to your PC.

Do not use the CAT-5 cable included with AudioTron to connect directly to the PC’s Ethernet interface without
a Hub. A connection made without a hub requires a special “Crossover cable”.
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To connect AudioTron to an Ethernet Network...

1. Insert the Cat-5 Ethernet RJ-45 cable (included with your AudioTron) into the connector labeled
ETHERNET on the AudioTron rear panel.

2. Insert the other end of the cable into your Ethernet hub, which in turn connects to a network interface card
in your PC.

3.  Proceed to the section called “Configuring AudioTron’s Network Settings”.

Figure 12 Connect AudioTron to an Ethernet Hub with the included CAT-5 cable.
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Configuring AudioTron’s Network Settings

=

If you experience any problems setting up AudioTron with your configured network, please see if the
issue is addressed in the “Network Troubleshooting Procedure”, “Troubleshooting Tips” or “Network
Basics” sections in this manual or in the FAQ section of the Turtle Beach web site.

Before you begin...

v' File sharing... Your digital music files must be in directories called \Music, \Audio \My

Music or \My Documents \My Music. These subdirectories must be located under a shared
directory for AudioTron. For more information on how AudioTron uses “shared” directories,
refer to the Appendix called “Shared Directories”.

TCP/IP... Regardless of whether you're using HPNA or Ethernet, AudioTron requires a
network that is running the TCP/IP protocol. Y our network may be running fine, but it may not
be using TCP/IP. If you aren’t sure if your network is running TCP/IP, see the Appendix called
“Network Basics”.

IP Address... Every devicein a TCP/IP network, whether it's a PC or AudioTron, needs an
“1P address” in order to send and receive data on the network. This section will tell you how to
set thisup for AudioTron. If you want to know the details about IP Addresses, see the
Appendix called “Network Basics”.

If you’re using a DSL or Cable modem with a Router/Hub... Many Router/Hubs (e.g. the
Etherfast Cable/DSL Router from Linksys), also act as DHCP servers. Check with the
manufacturer of the device to seeif thisisthe case for your Router/Hub device. Y ou should
also check with the manufacturer to see if there’ s an update for the device's firmware. See the
“Troubleshooting Tips” Appendix for details on firmware issues.

If your network has a DHCP (“Dynamic Host Control Protocol”) Server... An IP address
can either be assigned automatically by one of the devicesin the network (called a“DHCP
Server”), or you can “hard code’ an address into AudioTron (called “ Static IP” addressing.) If
your network has a DCHP server, AudioTron will automatically be assigned an | P address
when it's connected to the network. Since you can’t hurt AudioTron or your network by
attempting to automatically assign an I P address from a DHCP server, let’s give it atry to see
if it works.

To assign an IP address with a DHCP Server (on HPNA or Ethernet)...

1.

Plug AudioTron into the network connection (either HPNA or Ethernet, depending upon your network) and
make sure the PCs and network hub are all turned on.

Turn on AudioTron from the rear panel power switch, wait a few seconds, then press the front panel
Standby button. When powering on, AudioTron will detect if it is connected to the network through an HPNA
or Ethernet interface and choose the appropriate interface.

When the display indicates the type of network connection detected (Ethernet or HPNA), make sure it
corresponds to the type of network you're using. For instance, if you connected an Ethernet cable and
AudioTron’s display indicates it has detected HPNA, the cable is either not connected properly or the
Ethernet network may not be operating properly.

Once AudioTron detects the network connection, it will begin searching the network for a DHCP server.
(This could take up to 120 seconds, so wait until it's done.)

If AudioTron finds the DHCP server and is assigned an IP address, it will display “Searching for Hosts” and
will search for all the host PCs that have music files in shared directories (as explained in the Appendix
called “Shared Directories”.)

If AudioTron finds music files, it will display “Found xx Hosts” (where xx is the number of PCs it found) and
then begin to search for music files. After it's done finding songs, the main menu will appear and AudioTron
is ready to play music. From this point on, you should turn AudioTron on and off with the Standby button.
Turning off the rear panel power switch will erase the internal database of song titles and the network scan
procedure will be repeated the next time AudioTron is powered on.
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7.

If “No Hosts Found” is displayed, check the suggestions for “No Hosts Found” in the Appendix called
“Troubleshooting Tips”. Reboot AudioTron from step 2 above to repeat the process. If “No Hosts Found” is
again displayed, restore AudioTron’s default settings as described below.

To Restore AudioTron’s Default Settings...

Press the OPTIONS button. Turn the knob until the “Restore Factory Defaults” menu item is displayed.

Press the knob to display the “No/Yes” menu screen, turn and press the Knob to select “Yes” to restore the
factory default settings.

Reboot AudioTron from step 2 above to repeat the process.

If “No Hosts Found” is again displayed, it is possible that your network does not have a DHCP server (or if it
does, AudioTron can't find it.) In this case, you must manually assign an IP address using the Static IP
Address procedure as described below:

To assign a Static IP Address...

1.

10.

Find the addresses of the PCs in your network: Run the AudioTron Setup Utility from the CD included
with AudoTron to find the IP address, Subnet IP Mask and Gateway Address for each PC in your network.
These numbers will be used in a later step. See the Appendix called “Network Troubleshooting Procedure”
for details on running the Setup Utility.

Choose an IP Address that doesn’t conflict with the IP Addr of the PCs in your network:
Choose an IP Address for AudioTron that won't conflict with any of these addresses. For example, if there
are two PCs with the first set to IP address 192.168.0.1 and the second set to 192.168.0.2, then choose a
number for AudioTron that's at least 10 higher than the highest IP address already assigned. (e.g.
192.168.0.12 in this example). Choosing a number that’s significantly higher than any of the other IP
Addresses (but no higher than 254) will help assure that AudioTron won't conflict with other IP Addresses.

Select the network type (Ethernet or HPNA): Press the OPTIONS button on the AudioTron front panel.
Turn the knob until the menu displays “Select Network Interface” “Ethernet/Phone Line”. Turn and press
the knob to select the appropriate option for your network installation (Ethernet or HPNA).

Disable DHCP: Turn the knob until the “Configure DHCP” menu is displayed. Press the knob to display the
“Configure DHCP” “Enable/Disable” menu. Turn and press to select “Disable” to turn off the DHCP function.
Note that the Disable DHCP setting will cause AudioTron to ignore the IP Address, Subnet Mask and
Gateway settings assigned by a DHCP server.

Set the IP Address: Turn the knob until the “Configure IP Address” option is displayed. Press the knob to
display the “Configure IP Address” menu. Enter the number you've determined above in step 2 by turning
and pressing the knob to advance the numbers. When “Done” is flashing, press the knob to save the
changes.

Set the Subnet IP Mask: Turn and press the knob to select the option “Configure Subnet IP Mask”. Enter
the number obtained from step 1 for your network’s Subnet IP Mask. When “Done” is flashing, press the
knob to save the changes. Note that AudioTron is compatible with Class C networks, and may use a Subnet
IP Mask between 255.255.255.0 and 255.255.255.240.

Set the IP Gateway: Turn and press the knob to select the option “Configure IP Gateway”. Enter the
number obtained from step 1 for your network’s IP Gateway.

Set the “Sharing” Password (Optional): If you have password-protected your Shared directories, the
same password needs to be entered into AudioTron in order for it to access them. In the Options menu, turn
the knob to select the option “Share Password”. Press the knob to display the “Enter Disk Sharing
Password” menu. Enter the desired Password until the word “Done” is flashing. Press the knob and select
“Yes” in the display that follows. Press the knob to save the password. Note that passwords are case
sensitive.

Set the NT User Name and Password (Optional): If you're running an NT 4 or Win 2000 network, the NT
User Name and Password should match those set in AudioTron. In the Options menu, turn the knob to
select the option “Enter Password for User”. Press the knob and the “NT/Windows 2000 User Password”
display will appear. Enter the desired Password until the word “Done” is flashing. Press the knob and select
“Yes” in the display that follows. Press the knob to save the password. Repeat for the User Name. Note
that passwords and user names are case sensitive.

Re-start AudioTron: After entering AudioTron's network settings, turn off the power switch on the rear
panel. Turn the power switch back on. Wait a few seconds, then press the front panel Standby switch.
AudioTron will step through its power-on sequence and search for the host computer(s) on the network. It
will display how many PC hosts it has located and then search for music files on those hosts, finally
reporting the number of music files it has found.
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Connecting the Audio Outputs

Before you begin...

AudioTron includes both analog and digital audio (“S/PDIF") outputs, which operate slightly
differently:

v Thedigital output supports a fixed number of sample rates that adhere to the S/PDIF standard.
Thus, music files that are formatted in non-S/PDIF sample rates will not play out of the digital
output. For alist of supported sample rates, see the Appendix called “Product Specifications”.

<

The VVolume control will not affect the digital output.

<

On most audio systems, the digital output may have a higher volume than the anal og output.

To connect AudioTron’s analog audio outputs...

Figure 13 Use the included RCA-to-RCA cable to connect the Analog outputs to a stereo receiver.

1. Use the RCA-to-RCA cable included with your AudioTron to connect the AudioTron analog outputs to the
line inputs on your stereo receiver or amplifier. The line level inputs on your stereo receiver may be labeled
AUX, CD or LINE IN. Please refer to your equipment's documentation for details.

2. If your stereo system or powered speakers require a 1/8” connection, you'll need to obtain an RCA-to-1/8"
adapter to connect AudioTron to the stereo or speakers. This is available from the Turtle Beach web site.

3. Connecting the headphone output: AudioTron is also equipped with a 1/4" stereo headphone jack on the
front panel for use with headphones.

To connect AudioTron’s digital audio output...

Figure 14 Connecting the optical digital output requires an optional fiber optic cable (which may be purchased
from the Turtle Beach web site.)

1. Remove the plastic covers from the DIGITAL OUT connector on the AudioTron rear panel.

2. Connect one end of the optional fiber optic cable (available from the Turtle Beach web site) to the stereo
component's Digital Input and the other end to the Digital Out on the AudioTron back panel.
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Press PLAY

Audio Troubleshooting Procedure

What happened?

Song time indicator is
incrementing but you can't
hear the song play.

Song time indicator is
incrementing and you can
hear the song play.

Turn the Standby button
off and on.

Make sure the Mute button
isn't on.

Can you hear the song from
the headphone jack?

Are the audio outputs
properly connected?

Do any other songs in the
list play?

See the "Troubleshooting
Tips" Appendix.

No problem.

Standby resets the AudioTron's audio outputs.

Mute silences the audio output when the LED is lit.

If audio plays out the headphone output, Audiotron is working. Check the
stereo system and the audio cables to make sure they're set up properly.

Note: Inserting headphones will mute the rear panel analog line outputs.

Make sure the cables are connected to the proper audio inputs on your stereo receiver.

Try another cable or try the same cable on your CD player to confirm the problem is not
due to the cables and/or the inputs on your receiver.

Some songs may not play because they may have had formatting problems
when originally converted from CD. See the Reference Manual for more details.
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Playing Your Music Library with AudioTron

Song Selection Display

When powered on from the rear panel power switch and Standby button, AudioTron searches for
PC hosts on the network and catalogs all of the music filesit can find. After it completes this start-
up routine, the “ Selection” menu is displayed, which lets you sort songs by Title (individual song
titles), Artist (creator of the song), Album (the name of the CD the song came from), Genre (type of
music), and Lists (User-defined Playlists). The entries for these categories correspond to the “tags’
created with a PC jukebox program such as AudioStation, Music Match, Media Player 7, etc. as
described in the section called “Managing Your Music Library with AudioStation”.

Figure 15 Pressing the knob selects the item in the top Row. Turning the knob scrolls the item in the second row.

In this example, the word “Title” would be flashing to indicate that the second line is a song from
thelist of song titles, and turning the knob would scroll though all of the song titlesin the library.

Song Playback Display

Pressing the PLAY button starts song playback and displays the following information:

@ Song Title The song title appears in this field. If there is no Title embedded in the music file's
9 tags, the song's file name will be displayed.

Displays how long the song has been playing from the beginning. If the Song's file
contained information on its total length, this field will display both the current time
and the total time of the Song. If the Song is not playing, this field displays the
current status of the Song:

@ Play time/status

PAUSED - Indicates that Pause button has been pushed and the song is paused
at the current time. Press Pause or Play to resume playback.

STOPPED - Indicates that the Stop button has been pushed. Press Play to
resume playback. Note that there will be a slight delay from the time STOP is
pressed until the song stops playing, as AudioTron closes the file on the PC Host.

BUFFERING xx% - Indicates that the unit is downloading Song data from the
network into its internal data buffer.

MUTED - If the MUTE button is pressed, the word MUTE will flash to indicate
playback is Muted.

® Tags "Tags" are data embedded in the audio files that provide information about the
9 Song (e.g. song title, artist, album name, genre.) If no tags have been entered for
the song, the file name for the song will be displayed.

AudioTron supports MP3 ID3 version 1.0, 1.1 and 2.3 tag formats, WMA tags and
WAV tags created with the AudioStation 4.1 (or higher) included with AudioTron.

If the song Tags contain more information than can be displayed at one time, the
display will scroll in the manner of a "marquee”.

The current song number and total number of songs in the queue (i.e. the first song
@ Queue Status in an album that contains 14 songs will display as "1/14")
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To play a single song...

1.

=

Press the knob until the “Title” selection flashes. Turn the knob to select a song title from the song library.
(NOTE: Pressing the JUMP+ and JUMP- buttons on the Remote Control will skip to the first song in the next
letter of the alphabet, which provides a quick way to scroll through a large library.)

Press PLAY. AudioTron will transfer a portion of the song file from the PC Host to its internal memory buffer
for playback. The percent of buffer being transferred is shown by the "Buffering xx%” indicator. After the
buffer is adequately filled, the song will play once, then stop. The “time indicator” on the right side of the
display will advance as the song plays. To play the song repeatedly, press the REPEAT button.

If there are multiple songs with the same name in the library, AudioTron differentiates between them by
adding a number in parentheses after the name of the song (e.g., "This Song" and "This Song(1)", etc.).

If AudioTron will not play a particular song, or if the message “CLOSED” appears when the song is
loaded, see the Appendix called “Troubleshooting Tips”

AudioTron’s Internal Song Buffer

AudioTron plays music files by transferring data from the PC to AudioTron’s internal memory
(called a“buffer”). The music file istransferred as “packets’ of data, with the buffer holding
enough packets to assure that atemporary loss of datawill not cause the audio playback to drop
out.

The Options menu “Buffer Threshold” determines how much of the buffer has to befilled before

the song starts playing. With alower Buffer Threshold setting, the song will start to play sooner

because it will begin at a smaller percentage of buffer filled. With a higher setting, the song will not

play until a greater percentage of the buffer isfilled. If the buffer threshold istoo small, it may
cause “dropouts’ if increased network traffic causes the buffer to empty before new data arrives.

Note that since MP3 and WMA music files are compressed, they require a smaller buffer than

WAV files (which can be up to 10 times larger.) Therefore, WAV fileswill exhibit alonger delay
between the time PLAY is pressed and when the song begins playing.

To play songs by a particular Artist...

1.

Press the knob until the Artist list flashes. Turn the knob to select the Artist Name from the library of artist
names. (NOTE: The artist name is part of the “song tag” created by the PC jukebox program used to
transfer the song from a CD to your PC Host's hard drive.)

Press PLAY. The number of songs for the selected Artist will be displayed and the entire list of songs will
play once in alphabetical order. To play repeatedly and/or randomly, press REPEAT and/or RANDOM.

To play songs from a particular Album...

1.

Press the knob to select Album. Turn the knob to select the Aloum name. (Note that the lists of Albums are
listed in alphanumerical order by Artist name, not by the title of the Album.)

Press PLAY. The number of songs for the selected Album will be displayed and the entire list of songs from
the Album will play once in alphabetical order.

To play songs of a particular Genre...

1.
2.

=

Press the knob to select Genre. Turn the knob to select the Genre name.

Press PLAY. The number of songs for the selected Genre will be displayed and the entire list of songs will
play once in alphabetical order.

The list categories “Title, Artists, Albums and Genre” are part of the “song tag” created by the PC
jukebox program used to transfer the song from a CD to the hard drive. When an entry from these lists is
chosen, AudioTron searches the song library for a song that matches the tag. If a song was entered
without tag data, its file name (rather than song title) will appear when the Title category is selected. The
file name will not appear when Artist, Album, Genre are selected. For more information on Song Tags,
see the section called “Managing your Music Library with AudioStation”.
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To play songs from a PC Play List...

1. Play Lists are groups of songs created on the PC using a Jukebox program such as AudioStation. For
information on Playlists, see the section called “Managing your Music Library with AudioStation”.

2. To select a playlist, press the knob to select List. Turn the knob to select the List name.

3.  Press PLAY. The number of songs for the selected List will be displayed and the entire list of songs will play
once in the List order.

To refresh AudioTron’s internal song and playlists database...

1. Press the OPTIONS button to display “Check for new music?”

2. Press the control knob to select “Yes”. AudioTron will search the network for music files and playlists not
already in its local database. If any new music files are found, the titles will be added to the database.

= The Remote Control “Net” button can also be used to perform this function.

= The “search for new music” function does not remove songs or playlists that have been deleted from the
PC hard drive. It also does not capture new tag information or playlist changes. Refreshing the
AudioTron database for these changes requires AudioTron to be powered off and on so that it re-scans
the network drives for music and rebuilds its internal song database.

To Search for new networked PCs...

When anew PC is added to the network, AudioTron must be powered on with the rear-panel power
switch in order to recognizeit. To do this, turn the rear panel power switch off and on, wait afew
seconds and press the Standby button. Thiswill cause AudioTron to re-scan the network for new
hosts and music files.

To set the Volume...

Turning the Control Knob while asong is playing (or if the volume buttons are used on the remote)
will momentarily display the volume setting. This setting will only affect the anal og outputs on the
back panel and on the headphones—the S/PDIF digital output volume will not be affected.

The volume setting indicates the “ attenuation” of the signal level. A setting of 0dB ("zero
decibels") indicates that there is no attenuation (i.e. "full volume") of the signal being sent out the
analog outputs. Turning the knob will attenuate the signal by -1dB steps. The volume setting is
saved in internal Flash RAM when the Standby button is turned off. When turned back on, the
volume will return to the saved setting.

The Voolume Control should be left at the 0dB (maximum) setting unless AudioTron is used with headphones
or powered speakers that do not have a volume control.

For best fidelity, the volume control on your stereo system or powered speakers should be used to control
the playback level.
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Creating a Group of songs

The Group button provides a quick way to create a playlist of songs from the AudioTron front
panel or with the remote control.

To create a Group of songs ...

1.

Press the GROUP button to activate Group Mode. Press CLEAR to remove any previously loaded songs
from the Group.

For this example, in the main menu display, select Album by pressing the knob until ALBUM flashes (or by
pressing the ALBUM button on the remote control.) Turn the knob (or press the NEXT/PREYV buttons on the
Remote Control or the front panel) to Scroll through the list of Albums. In this example, assume we have
chosen Revolver by The Beatles.

Press the “ADD” button to add the songs from this Album to the Group. In this example, 14 songs have
been added to the group.

For this example, assume we selected Sting as an ARTIST in the same manner. Assuming Sting has 10
songs in the library, pressing ADD would add all of these songs to the Group. At this point, there would be
14 + 10 = 24 songs in the Group.

Now assume we selected a single song by pressing TITLE. Pressing ADD would add this song to the list
and there would be 14 + 10 + 1 = 25 songs in the Group.

At this point, pressing PLAY would start the first song in the Group of 25. Pressing LOOP will cause the
group to begin playing again after the last song is over. Pressing RANDOM would play the songs in random
order.

Turning off the GROUP button would return to normal operation. Turning it back on would again load the
same 25 songs in the Group.

Press CLEAR to delete all of the contents in the group and start over. Note that individual songs in the
Group list cannot be deleted.

3 Turning off the AC power to AudioTron will delete the Group contents.

Placing AudioTron in “Standby mode” will not delete the Group.

To play the songs in your music library using Group ...

1.

When powered on from the rear panel power switch, AudioTron loads the songs from your music library into
the GROUP.

Press PLAY to play these songs once from the first to last. Press RANDOM to play all of the songs once in
a random order. Press REPEAT to play the songs over again once they've all been played.

If you've loaded new songs into the Group, you can reload the songs from the music library by powering
AudioTron off and back on with the rear panel power switch.

3 You must first Clear the Group before adding songs to your custom play list, or the songs will be

added those already in the Group.

Page 26



AudioTron Reference Manual

Using the “Favorites” Remote Control Feature

The “Favorites’ feature lets you associate a song title, album,
artist, genre or playlist to the Favorites Buttons on the Remote
Control so you play them with a push of a single button.

The IR Remote Control includes a set of 20 user programmable
buttons, grouped as 16 “FAVORITES” buttons (labeled 1 — 16)
and 4 “PRESETS’ buttons (labeled A, B, C and D). When one of
these buttons is pressed, the current playing song (if any) is
stopped and AudioTron will load the lists associated with the
button.

To assign the Favorites and Presets buttons on the
Remote Control...

1. Select a List (Title, Artist, Album, Genre, Lists) in the main menu
display. In the example below, the song “Monkey and the Hitman” has
been selected.

2. Press the “ADD FAV” button on the remote control and the display will
ask if you want to add the selected Song to one of the Favorites
buttons on the Remote Control.

-

3. Press one of the 16 “Favorites” buttons or one of the 4 “Preset” buttons on the Remote control. For
example, if you press button #1, the # sign in the display will change to a “1”, indicating the number of the
button pressed. From this point on, pressing Favorites Button 1 will load and play this song.

4. To re-assign a song or list to a button that has been assigned, follow the same process to overwrite the
previous contents.

5. To assign all of the songs from an Album, Artist, Genre or List to a Favorites button, follow the same
procedure but choose the category in step 1.

3 Turning off the AC power to AudioTron will delete the “Favorites” contents.

Placing AudioTron in “Standby mode” will not delete the “Favorites” contents..
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Managing Your Music Library with AudioStation

Using the Voyetra AudioStation Jukebox Software

The Voyetra AudioStation jukebox
program included with AudioTron
lets you:

Play audio CDs from your PC's
CD ROM drive.

Transfer songs from a CD to the
PC hard drivein WAV, MP3 or
WMA formats (using Windows
98/ 98SE or Me) for use with
AudioTron.

Obtain track tags (CD title, artist,
track names, etc.) from the
CDDB™ database using an
Internet connection.

Create custom playlists of music
tracks for use with AudioTron.
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Figure 16 The Voyetra AudioStation PC jukebox program lets you
manage your music library.

With AudioStation, you can manage and play the music library on your PC using the same type of

“selection lists’ as AudioTron, including:

All Tracks (equivalent to “Title” in AudioTron’s selection display) — Displaysall tracksin
the music database. In addition to MP3, WMA and WAV files (which are compatible with
AudioTron) the All Tracks feature will display CD audio tracks, MIDI filesand AVI movie
files, which can be played on your PC with AudioStation.

Albums — Displays songs grouped by CD title.

Artists — Displays songs grouped by Artist name.

Genres — Displays songs grouped by Genre.

User Defined (equivalent to “Lists” in AudioTron’s selection display) — Displays songs

grouped into custom playlists.

AudioStation may be controlled by an optional RF Remote Control unit, which lets you access
playlists and control your music library from distances of up to 100’ from the PC—even through
walls. For more information, please visit the Turtle Beach web site (www.turtle-beach.com)

AudioStation includes comprehensive online help, which contains a Quick Start tutorial along with
detailed descriptions of the interface and controls. To access AudioStation Help, launch
AudioStation either from the AudioStation desktop icon, or from the Start Menu in Start >
Programs - AudioStation - AudioStation 4. Then click on the Help Contents in the program.
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Song Tags (Title, Artist, Aloum, Genre, etc.)

A song “tag” (also called an “Attribute” or

“Track Information”) refers to data embedded sk rfomaton |

as atext header in the MP3 or WMA file. The ey —— - d
data includes pertinent information about the | bk [
track, such as artist, title, genre, etc. which can o I |

be automatically obtained from the CDDB . e El
database by logging onto the Internet before - A L -

placing the CD in the CD tray. The data can |

also be entered manually. suiizﬂ-li =

When transferring music from a CD to the L

hard drive using the AudioStation software, the

tag information can be viewed in the Track I O |
Information dialog, accessed by selecting File , ) ) _ _

- Edit Track Info. Figure 17 The AudioStation "Track Information” dialog

shows the track Tag data.
Unfortunately, there are many versions of tag
formatting, which can lead to incompatibilities among tag data. The proper management of tag data
isimportant for optimum use of AudioTron because it affects how songs are accessed in the main
menu. For this reason, it is suggested that the track tag information be carefully checked each time
aCD isconverted to digital format, so that the tag data will be consistent. For example, it isbest to
avoid entering artists as “ The Beatles’, “Beatles” and “Beatles, The”, since thiswould create three
separate categories for the same artist and make it difficult to find tracks by that artist.

Aslong astags for Genre, Artist, or Album exist within AudioStation’ s database, you can drag and
drop files from the right side “ playlist” screen into the appropriate category on the left side
“library” screen and AudioStation will change the tag accordingly. This operates like a“batch
editor” for tags and is useful for cleaning up inconsistent tags.

For more information on tags, check out the web site www.ID3.0rg.

AudioTron can display tag information saved in the ID3 version 1.0, 1.1 and 2.3 formats. Tags in
other formats may not display properly.

Security Features in WMA Music Files

The WMA file format provides a“ security” feature that encrypts song files so they may be played
but not copied. AudioTron cannot play music files encrypted with this security feature.

The security setting in Windows Media Player 7 and AudioStation jukebox programs should be
turned off before converting CD tracks to WMA files for use with AudioTron. Once recorded, a
song’s security feature cannot be turned off. The song must be re-recorded with the security option
turned off.

AudioTron cannot play songs recorded with the “secure” feature enabled, so be sure to disable
this feature on AudioStation or other jukebox program when converting CD tracks.

To turn off the WMA recording security feature in AudioStation...

1. Activate the AudioStation “Preferences” dialog by clicking on Options - Preferences.
2. Click on the “Record Options” tab

3. Select “Windows Media” in the format pull-down menu.

4

Un-check the option labeled “Secure my music files when encoding”.
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Digital Music File Formats

AudioTron plays music files stored in the MP3, WMA and WAV formats.

WAY format preserves CD-Quality audio, which is sampled at 16 bits 44.1kHz. Although this
isthe purest form of audio, it also takes up a significant amount of hard drive space (atypical
three-minute song consumes more than 30MB of hard disk space.)

MP3 (MPEG-1 Layer III) format uses a compression process that implements psychoacoustic
principles to reduce the file size while preserving a high level of sound quality. Digital music
files encoded using MP3 technology ("M P3 files") are very popular on the Internet, due to their
combination of good sound quality and small file size (a three-minute song can be reduced to
less than 3MB—a factor of 10 reduction as compared to WAV format.)

WMA (Windows Media™ Audio) format was developed by Microsoft as an alternative to
MP3 for compressed digital audio. Similar in many ways to the equally common MP3 format,
WMA offers equal sound quality in an even smaller file size.

MP3 and WMA compressed audio formats reduce the size of an audio file by removing some of the
sounds determined to be “inaudible”. Although the playback quality of these compressed audio
formatsis good enough for most listeners, some audiophiles can hear the difference between
compressed and uncompressed audio. For thisreason, AudioTron is capable of playing true CD-
Quiality audio in uncompressed WAV format when used with an Ethernet network.

Playback of uncompressed WAV audio will be most important for audiophiles who can discern the
loss of dynamic range and other limitations of compressed audio formats. For these listeners,
maximum fidelity will be achieved when playing WAYV files through AudioTron’s S/PDIF optical

digital output.

In most cases, the MP3 or WMA formats offer acceptable listening quality, especially when
recorded at the higher sample rate options. However, the following table lists some of the issuesto
consider when deciding which format to use for storing music files:

WAV format benefits

WAV format drawbacks

Preserves all of the qualities of the original CD
recordings by maintaining the original 16-bit,
44.1kHz standard used for CD recordings. MP3 and
WMA formats remove audio information that is
determined to be “inaudible” in order to compress
the file size.

The highest fidelity is achieved when using
AudioTron's optical digital output with uncompressed
WAV format.

WAV format lets you burn high-quality custom CDs
from your music library (using third-party programs.)
Although some programs will create a CD from files
saved in MP3 or WMA format, these compressed
formats must be converted to uncompressed WAV
format prior to creating the CD. This process will
reduce the audio quality of the resulting CD.

Typically, WAV format does not include song tags as
do MP3 and WMA formats. So, AudioTron will only
display the file name and can’t display or sort songs by
title Artist, Album, Genre, etc.. However, the
AudioStation 4.1 program lets you add tag information
to WAV files so that they can be sorted and displayed
just like WMA and MP3 formats.

WAV files cannot be transferred to portable digital
audio players. Typically, these players are only
compatible with MP3 and WMA formats.

WAV format can take up more than 10 times as much
hard drive space as MP3 and WMA formats.

AudioTron does not support WAV format on an HPNA
network. Ethernet network is required for playback of
WAV files.
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To convert a CD into a digital music file with AudioStation...

1.

Set the recording format (MP3, WMA or WAV): From the “Record Options” dialog, select “Options >
Preferences > Record Options”.

= If you're using WMA format, uncheck the option labeled “Secure my music files when encoding”
(AudioTron can't play WMA files recorded in secure format.)

= Turning off the “Play file while Recording” option will significantly speed up the recording process.

= Setting the “Quality Level” to a higher number will improve fidelity but produce larger files. Settings of
160kbps for MP3 and 96kbps for WMA should produce good fidelity for most listeners.

Read the CD tracks: Place the CD in the tray and AudioStation should automatically read the tracks, listed
as Track 1, Track 2 etc.. You can enter the tag data manually for each track by highlighting the track, then
selecting “File > Edit Track Info...”, or you can use the CDDB feature to automatically load the tag data.

Loading track names with the CDDB feature: If you're logged on to the Internet and have the CDDB
feature enabled, the track data should automatically appear after CDDB searches its database for your CD.
If CDDB doesn’t launch, make sure you have the CDDB feature enabled in the “Options - Preferences -
CDDB" dialog box. If it's turned on, try refreshing the CDDB feature by selecting “View - Refresh CDDB
Info”. If you still have problems, try again later, just in case the CDDB system is temporarily inactive.

Record the CD tracks: After you're done entering the tag data for the CD, press the AudioStation record
button. Any track with a check mark on the left side will be recorded into the format (WMA or MP3) selected
in the “Record Options” dialog.

Creating playlists

A Playlist isagroup of music files saved in a special format with the .M3U extension.
AudioStation can export M3U playlists for use with the “Lists’ menu item AudioTron’s main
display. AudioTron searches for these M3U playlistsin the shared directories where the M P3,
WMA and WAV music files are stored, as described in the Appendix “Shared Directories”.

The default AudioStation playlist directory is C:\My Documents\My Music\AudioStation. If you
have M3U playlists from other PC jukebox programs, they may be imported into AudioStation by
selecting the “Import Playlist” option from the AudioStation “File” menu. To access playlists with
AudioTron, you need only move the files to an AudioTron music directory so that AudioTron may
access them when scanning the hard drive for music and playlist data.

To create an AudioStation Playlist...

1.

o 0o » w

Click on the AudioStation Music Library tab in the left pane to see a Windows Explorer-style directory tree of
the playlists available in AudioStation. Right click on the “User Defined” folder in the Library tree and choose
“New Playlist” in the pop-up menu. Alternatively, you can click on the “New Playlist” button at the top of the
music library window.

Right click on the “New Playlist” folder, enter a name for the playlist, (in the same manner as you would
rename a directory folder in Windows Explorer.)

Click on the “All” folder at the top of the Library tree to show the tracks in the music library.
Drag and drop tracks from the Playlist pane (on the right) to the “New Playlist” folder in the Library tree.
Click on the “New Playlist” folder to see the contents of your playlist.

Save the playlist in the directory used for your music files (e.g. \My Music) by selecting “Export Playlist” in
the AudioStation “File” menu.

To view the Artist, Genre, Album and Playlists in AudioStation’s database....

Select the “Open Playlist” option in the AudioStation “Files” menu.
Scroll over the “Album, Artist, Genre, User” categories in the menu to see the items in each category.

Highlight and left-click on the desired selection to load the tracks into AudioStation.

Page 31



www. Turtle-Beach.com

Turtle
- Beach

Front Panel Reference
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® Headphone Jack

Drives headphones. Volume is set with the control knob while a song is playing.

When headphones are connected, the rear panel analog outputs will be muted. The digital audio
output is not affected.

@ standby button

After turning on the AC power with the rear panel switch, the front panel Standby button is used for
turning the unit on and off.

The rear panel AC switch shuts down the entire unit, while Standby only shuts down the display
panel and certain internal functions so that power is maintained to internal memory and processor.

The red light under the Standby button indicates that the rear panel AC Power switch is “on”. The
red light flashes when the Remote Control is used, indicating that the IR signal was received.

To Reset AudioTron — Turn the back panel AC power switch off, then on. Wait a few seconds and
press the Standby button to turn on the unit. This will initiate a complete start-up sequence where
the unit searches for network hosts, songs, etc.

To “soft” Reset AudioTron — Press the Standby button off, then on, to reset the audio outputs if
there is no sound on the analog line and headphone outputs.

® Playback Buttons

Play — Starts playback of the currently selected Song or Playlist.

Stop — Stops playback of the current Song or Playlist.

Pause - Pauses playback if a Song is playing and resumes playback if a song is Paused.

Next >> — Selects the next song in a List. In the Select menu, selects the next item.

Previous << — Selects the previous song in a List. In the Select menu, selects the previous item.

@ Options Button

Activates “Options Mode” where you can search for new music, change AudioTron network
settings, restore default settings, and more.

See the section entitled “Options Menu” for details.

® Repeat Button

Plays songs continuously. The light is on while playback is in Repeat mode.

® Mute Button

Mutes the analog and digital audio outputs. The light is on while audio is muted.

@ Random Button

Plays songs in random order. The light is on while playback is in Random mode.

Group Buttons

Group - Activates Group mode for creating a quick playlist. See the section entitled “Using Group
Mode” for details.

Add - Adds the currently selected song, album, list, etc. to the group.
Clear — Deletes all songs from the group.

The RANDOM and LOOP buttons also work when playing the songs in a GROUP list. You can
press RANDOM and LOOP so that all of the songs in your Group will play in random order, in an
endless loop.

@ Infrared (IR) sensor

The infrared (IR) sensor receives commands from the Remote Control. The IR sensor is located
next to the Control Knob, on the front of the unit.

® control Knob

The operation of the Control Knob depends on the context in which it is used. Functions are
described in the various sections of this manual.

While a song is playing, turning the knob adjusts the playback volume.
In certain menu operations, pressing the knob initiates a selection.
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Options Menu

The OPTIONS button activates the Options Menu display. Turn the Control Knob to scroll through the available menu items and
press the knob to select.

NOTE: Any change made to an option listed with an R will not take effect until AudioTron is re-booted:

Check for New Music

Checks for any new music files stored on PC music server (Host PC). Does not search for
new host PCs.

Bass Boost
(default = 0)

Activates the Bass Boost control. Turn the knob to set the level in 1dB increments.
Bass boost does not affect the S/PDIF digital output.

Treble Boost
(default = 0)

Activates the Treble Boost control. Turn the knob to set the level in 1dB increments.
Treble boost does not affect the S/PDIF digital output.

Display Network History
(press Options button to exit)

Displays a series of character strings that indicate what happened when AudioTron logged
on to the network. The display strings include:

Local MAC address = x:x:x:x:x:x — The local MAC (ethernet) address for AudioTron.

Local IP Address = x.x.x.x — The IP address that AudioTron is currently using. If static IP
Addressing is configured, this setting should be the same as the static version. If DHCP is
configured, then this is the address that was assigned by the DHCP server.

Local Net Mask = x.x.x.x — The net mask that AudioTron is currently using. If static IP
Addressing is configured, this setting should be the same as the static version. If DHCP is
configured, then this is the mask that was assigned by the DHCP server.

Initial Search at x days x hrs x mins — Indicates that the first search of the network
occurred at this amount of time since the AudioTron was booted.

Host [hostname] found at IP x:x:x:x — Indicates that the host was found at the indicated
IP address.

Update Search at x days x hrs x mins — Indicates when the last search for new music
occurred.

Share [sharename] has xx new songs — Indicates the number of new songs found on
the indicated share.

[Sharename] - Share Access Denied — Indicates that access to this share was denied
because the share password was wrong.

[Sharename] — Error accessing share — Indicates that there was a non-password related
error accessing this share.

[Hostname] — Access to host denied — Indicates that the NT username and password
are incorrect.

[Hostname] — Error accessing host — Indicates that there was a non-password related
error accessing this host

No Name for host at IP x.x.x.x — Indicates that no name was found for a host found at
that IP address, therefore TCP/IP was installed but File Sharing was not installed or not
bound to TCP/IP.

Configure DHCP
(default = Enabled)

Enable — For connecting AudioTron to a network with a DHCP server so that AudioTron
will automatically accept a valid IP address from the DHCP server PC.

Disable — For configuring AudioTron with a static IP address as described in the “Set IP
Address” option (see below).

NOTE: If DHCP is Enabled, the settings in Select Network Interface, Set IP Address,
Configure Subnet Mask and Configure IP Gateway will be configured automatically. Any
manually added settings in these menus will be ignored.

Select Network Interface

Ethernet — For connecting AudioTron to a 10BaseT-compatible Ethernet network.
Phone Line — For connecting AudioTron to an HPNA 2.0 network.

Configure IP Address
(default = 192.168.0.10)

If DHCP is Disabled, lets you enter an IP address for AudioTron to use on your home
network. A typical IP address is 192.168.0.xxx where the xxx setting ranges from 1 — 254
as determined by the Subnet mask (a “Class C” network IP address).

Configure IP Subnet Mask
(default = 255.255.255.0)

If DHCP is Disabled, lets you enter an IP Subnet Mask that should match the one on your
network. A typical subnet mask setting for a Class C network is 255.255.255.xxx, where
the xxx setting ranges from 0 — 240 and sets the valid starting point for an IP Address in
the network. (e.g. O signifies a valid IP address range of 1 — 254.)
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R Configure IP Gateway If DHCP is Disabled, sets the IP address of the network Gateway (your host PC). This
(default = 192.168.0.1) must match the setting on your host PC.
R Share Password Sets a global password for accessing shared directories. If the host PC is running

(default = none) Windows 98 or Me, only one (global) user password may be used with AudioTron.

R NT/Windows 2000 User Sets a “User Name” used when your host PC is running Windows NT 4.0, Windows 2000

Name or Linux*. Note that the user name is case sensitive.

(default = atron)

R NT/Windows 2000 User Sets a “User Password” used when your host PC is running Windows NT 4.0, Windows

Password 2000 or Linux*. Note that the password is case sensitive.

(default = atronpass) NOTE: Passwords are intentionally not displayed on the screen for security reasons.

Search Whole Share No — Retains the shared-directory restrictions described in the Appendix “Shared

(default = No) Directories”, which causes AudioTron to search only in directories with specific names
located under a root share.
Yes — Defeats the above restriction and causes AudioTron to search all shared directories
for music and playlist files. Note that this could significantly increase the search time if the
number of files in the shared directories is significant.

Message Time Out Controls the display time for messages.

(default = 1 sec)

Restore Factory Defaults Yes — Resets AudioTron to its original factory default settings and discards all user-
customized changes. Re-start AudioTron for the default settings to take effect: Turn the
rear panel power switch off and back on. Wait a few seconds and press the front panel
Standby button. Once the start up procedure is completed, AudioTron will be operating
with the original factory default settings.

Set Prebuffer Threshold Sets the point at which the song begins to play as the buffer is filled. Smaller setting will

(default = 1 buffer) start the song sooner, but could result in audio dropouts. Longer setting will take longer for
the song to start as it waits for more of the buffer to be filled, but will reduce dropouts.

R Update Flash Updates the internal software ("flash the firmware") from a file on the host PC. See the

section entitled “Updating AudioTron’s Firmware” for details.

Button Test Diagnostic

A diagnostic menu that is used for testing the operation of front panel buttons, control knob
and remote control.

* Please note that Voyetra Turtle Beach, Inc. cannot provide technical support for users running Mac or Linux on their
host PC(s).
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Rear Panel Reference
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Ethernet Network Connector - Use the included Category 5 Ethernet cable to connect this jack

O ETHERNET to a 10BaseT Ethernet network hub or switch.
AudioTron will also work with a dual speed 10/100 hub, but will not work with a 100baseTX-only
hub or switch.

@ PHONE When AudioTron is connected to an HPNA phone line network, this jack may be used to connect
a telephone or to cascade a second AudioTron via the HPNA connection.

3@ LINE HPNA Network Connector — Connect the included telephone cable to this jack when using

AudioTron on an HPNA home phone line network.

@ DIGITAL OUT

S/PDIF optical digital audio output - Connect to powered speakers or stereo receiver with an
optical digital input. Connect with an optical TOSlink cable (not included).

® ANALOG OUT

RCA Analog Line Outputs (L/R) - Connect to powered speakers or stereo receiver with RCA
line input jacks.

® AC Power Connector

Insert the female end of the included three-pin IEC power cord into this receptacle.

@ AC Fuse

Receptacle for a 250mA Slo-Blo 250V mini-fuse.
To Replace the fuse:
1. Remove the electrical cord from the rear panel receptacle.

2. Take a small flat-blade screwdriver and insert into notch. Gently pry out the fuse holder
cover with the screwdriver. Take note of how the plastic was aligned in the holder.

3. Take out the old fuse and replace with a new mini-fuse of the exact same type and rating (5
x 20 mm, 250mA or 1/4 Amp, 250V Slo-Blo® UL/CSA cartridge type).

4. Put the fuse in the plastic holder and press the holder back into place on the AudioTron rear
panel. Be sure to re-insert the holder in the same way it was originally installed.

AC Power Switch

Use this switch to power up AudioTron for the first time, or to turn off all power to the AudioTron
(this should only be necessary when you want to completely disconnect the unit or you need to
perform a complete 'reset).

Once AudioTron is powered on, the rear panel power switch should be left on and the unit should
be turned on and off with the Standby button. Turning AudioTron on and off with the Standby
button avoids the network search process initiated by the “power on” sequence and retains
AudioTron’s temporary settings, so it's ready to play music with your custom configuration
settings.

If AudioTron is acting erratically, or if you want to rescan the network, “reset” the unit by turning
the rear panel power switch off and on, wait a few seconds, then pressing the Standby button.
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Remote Control Reference
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NOTE: The Remote Control functions may be checked
by using the Options “Button Test Diagnostic”. See the
Options Menu section for details.

As with the buttons on the AudioTron front panel, most
of the Remote Control's buttons activate asingle
function, while some serve multiple purposes depending
on the active display.

Buttons that function similarly to the front panel controls:

GROUP, ADD, CLEAR (Group Mode controls) — Equivalent to
the front panel Group, Add and Clear buttons.

POWER - Equivalent to the front panel Standby button

MUTE - Equivalent to the front panel Mute button. Silences the
audio playback.

PLAY, STOP, PAUSE - Equivalent to the front panel transport
buttons

<>l Equivalent to the front panel previous/next track
buttons. When in Select modes, these buttons also scroll through
lists in the same way as turning the Control Knob. The scrolling
speed will increase as the buttons are held down longer.

VOL+ (volume up), VOL- (volume down) — Equivalent to the
front panel Control Knob when in Play Mode (Volume Control).

RANDOM / REPEAT - Equivalent to the front panel Random and
Repeat buttons.

Buttons that are not available on the front panel:

FAVORITES - The 16 “Favorites” buttons work in conjunction
with the ADD FAV button to quickly activate favorite songs and
lists by pressing one of the FAVORITES buttons. See the section
Using “Favorites” Mode for details.

ADD FAV (Add Favorite): This button is only active in the select
screen (Select Mode). It prompts the user to select a favorite slot
and saves the current selection type and entry into the Favorites
slot you choose. See the section Using “Favorites” Mode for
details.

JUMP + (jump forward) and JUMP — (jump back): Jumps forward
or back to the next entry that does not begin with the same
character (case insensitive) as the current Entry. Makes it easier
to navigate through long lists of songs.

PRESETS - These are 4 additional favorites buttons grouped
into a separate area for quicker access. Use these buttons for
assigning “favorites” you intend to use often.

TITLE, ARTIST, ALBUM, GENRE, LISTS (List Selection
Buttons) — Equivalent to the categories in the main menu for
selecting lists.

NET (Network): Equivalent to the “Check for New Music” Options
display, which causes AudioTron to scan the network for new
music files.
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Product Specifications

Ethernet Network Support Ethernet 10BaseT (10 Mb/s Ethernet) or 10/100BaseT running TCP/IP. Not
compatible with networks which support only Fast Ethernet 100BaseTX (100 Mb/s).

HPNA (Phoneline) Network Support HPNA 2.0 running TCP/IP

Analog Outputs (line level) Stereo RCA jacks on rear panel

Analog Outputs (headphone) Stereo 1/4" phone jack on front panel (rear panel analog outputs are muted when
headphones are inserted)

Signal to Noise Ratio 91dBA

THD+N 0.02%

Crosstalk -66dB @ 1 kHz

Analog Line-Level Output Impedance <1000 ohm

Headphone Output Impedance <10 ohm

Frequency Response 20 Hz - 20 kHz

D/A sampling rates 8 kHz, 11.025 kHz, 16 kHz, 22.05 kHz, 32 kHz, 44.1 kHz

Volume Control Variable from -96dB to 0dB in 1dB increments

S/PDIF (Digital Output) TOSIlink Fiber Optic connector for Sony/Philips Digital Interface
Volume, Bass Boost and Treble Boost controls have no effect on S/PDIF output.

S/PDIF sampling rates supported 32 kHz, 44.1 kHz

Maximum number of song titles in More than 30,000 depending upon the of amount of data associated with each song,

database (e.g. tag data and directory location.)

Dimensions 17 x 1.75 x 10 inches (430 x 44 x 250 mm)

Weight 5.2 Ibs. (2.4 Kg)

Power Requirements 90VAC - 135VAC 50/60Hz 250mA max

Remote Control Requires 2 AAA batteries

Playlist Formats PLS & M3U: MP3 tags version 1.1 and Version 2.3 formats/ WMA tags/ WAV tags

created with AudioStation 4.1 or higher.

Supported Digital Music File Formats

Format Network Bit/Data Rates Sampling Rates (KHz)
MP3 HPNA & Ethernet Al bit rates up to 320 kbps ~ 44.1/ 32/ 22.05/ 16/ 11.025/ 8 Khz
Unsecure Microsoft HPNA & Ethernet 32 kbps 22.05/32/44.1 kHz (mono)
WMA 36 kbps 32 kHz
(all formats listed are 32 tggz 25 :Z:i
flt)etreedc;' except where 48 kbps 32/44.1 kHz
64 kbps 32/44.1 kHz
80 kbps 44.1 kHz
96 kbps 44.1 kHz
128 kbps 44.1 kHz
160 kbps 44.1 kHz
192 kbps 44.1 kHz
WAV PCM Ethernet 16-bit stereo 32/44.1 kHz (analog and digital outputs)
(uncompressed) 8/11.025/ 16/ 22.05 kHz (analog outputs only)

The SPDIF digital output will only play the 32 kHz and 44.1 kHz sample rates. The analog audio outputs can play
uncompressed WAV PCM digital audio files recorded at sampling rates of 8 kHz, 11.025 kHz, 16 kHz, 22.05 kHz, 24
kHz, 32 kHz, and 44.1 kHz. AudioTron cannot play uncompressed WAV digital audio files recorded with a sampling
rate of 48 kHz.
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Appendix A: Troubleshooting Tips

Why does the music sometimes “skip” when playing?

Under conditions of extremely heavy use, your network might be unable to provide an adequately
sustained quantity of digital audio data to the AudioTron while playing music. For instance, if
many users are transferring files on the network at the same time, or if the music server PC is being
used for a high-overhead task such as playing a PC game, the music server PC might put off the
task of sending music over the network. If this happens for a period of time that causes the
AudioTron’s internal music buffer to become empty, it is possible for the music to skip due to data
loss. To reduce the possibility of this, try the following:

v Minimize usage of the music server PC while AudioTron is accessing music files stored there.

v’ Use adedicated PC for music storage so it will not be used for other tasks while playing music.
See the section called “ AudioTron Music System Configurations” for details.

v’ Try alarger buffer threshold to allow more buffer to be filled before the music starts playing.
See the Options Menu section called “Set Prebuffer Threshold”.

v’ If you’re using WAV files... Try using MP3 or WMA instead. WAV files use uncompressed
data and therefore require as much as 10 times more data to travel over the network than do
MP3 and WMA files. Also, WAV files should be used only with Ethernet networks.

v If you’re running an HPNA network... Be sure you do not have alinefilter onthe PC's
HPNA interface or the AudioTron’s HPNA connector. Also, if the PC has a modem, try
connecting the HPNA interface and modem to the phone line with a splitter, rather than in
series with each other. See the section “Installing AudioTron on an HPNA Network”.

v"If only certain songs skip, try playing them on your PC with AudioStation to see if the song is
damaged. If it skips on the PC, it will also skip on AudioTron.

Why won’t AudioTron play certain songs? Why do some songs display the
message “CLOSED”?

v AudioTron will not play songs that are saved in “secure” format, which is an optional setting
used by PC jukebox programs that can record in WMA format. Check to seeif the song is set
to “secure” and if so, use the jukebox program to re-record the song from the CD.

v" Some MP3 and WMA files have odd sample rates that may not be compatible with AudioTron.
If the song was obtained from the Internet, it is possible that it was created in one of these non-
standard rates and is not recognized by AudioTron. Thisis usually not a problem with songs
created on the PC with a jukebox program, such as AudioStation, from a CD.

v Some MP3 files have large amounts of tag data embedded in the “header file”. This data can
include photos, artist information, and other information relating to the composition.
AudioTron might reject music files that have excessive data in the headers.

Why don’t some songs play on the S/PDIF digital output, but do play on the
analog outputs?

v Audio will only play through the optical S/PDIF output if the digital audio file was stored
using one of the standard S/PDIF sample rates of 32 kHz or 44.1 kHz. AudioTron does not
support playback of uncompressed WAYV files recorded with a sampling rate of 48 kHz. See
the Appendix called “Product Specifications” for details on supported sample rates.

v When converting your CD collection to the PC hard drive we recommend that you leave your
CD tracks at the 44.1 kHz sampling rate used on the CD itself. Re-sampling to a different
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sampling rate usually resultsin decreased sound quality and may be incompatible with the
SPDIF output.

v" Songs downloaded from the Internet from an unknown source may not have compatible SPDIF
sample rates and therefore might only play out of the analog outputs.

Why is there sometimes a delay between the time | press the Play button
and the time the music starts to play?

v When you press the “Play” button, AudioTron must first download a portion of the song file
from the PC before it can start the music. Therefore, there will be a short delay caused by the
digital file stream being transferred from the PC to the AudioTron. Thisisindicated by the
message “Buffering” on the Display Panel when the track isfirst selected.

v’ Try changing the “Pre-buffer threshold” as described in the Options Menu section. A shorter
threshold will cause the song to start playing sooner, but could result in audio dropouts.

v’ Because they are not compressed, WAV files require more data to be transferred before
playback can begin, and therefore will exhibit alonger delay than WMA and MP3 files.

v" If the PC on which the song resides isin “energy-saving” mode and has been idle long enough
for the hard drive to shut down, there will be an extra delay after pressing Play while the hard
drive starts up and begins to access the song file.

Why can’t AudioTron find my music files?

v Make sure your PC is powered on. If it is, then make sure the PC and hard drive are not set to
“power down” after a period of non-use. The control panel “Power Management” icon
launches a dialog box that will show how the power-save features are set. If your hard drive or
systemis set to shut down after aperiod of time, it will be inaccessible to AudioTron.

v Make sure your music files are located in shared directories with the proper names. Also,
check the password setting on the shared directories. If you have a password set, then it must
also be set on AudioTron. Also check that “file sharing” is set in the network control panel.

v' If you're using a LinkSys Etherfast Cable/DSL router, check that the firmware is version 1.37
or higher (see the manual on how to do this.) Firmware versions lower than 1.37 may have a
problem providing DHCP service and 1P Address access to AudioTron if the Linksysis used as
ahub for your network.

v AudioTron can’'t play WMA music files with the “security” option set. Since thisis the default
setting in AudioStation and Windows Media Player 7, it may be that you' ve transferred your
CDsto the hard drive in “secure mode” and AudioTron can’t access them.

v" I your Host PC is running “firewall” software, it must be set to “pass’ AudioTron’s |P
Address or it will be treated as an “unauthorized user” and be blocked from accessing the PC.

Why does AudioTron display “No Hosts Found” when first turned on?

AudioTron’s “Display Network History” Option can be used to check many of the network settings.
See the “Options Menu” section for details.

When powered up from the rear panel power switch, AudioTron will search the network for hosts
after the Standby button is pressed. If it does not find a host after searching for two minutes, it will
display “No Hosts Found”. If this occurs, check the following:

v Reconnect the network cable to make sureit “clicks’ when inserted.

v Try another network cable to make sure the problem is not due to a defective cable.

Page 39



Turtle

www. Turtle-Beach.com #. Beach

<

Make sure your PC is powered on.

v"If you're using DHCP, make sure that only one computer is configured as a DHCP server. If
you are using a"smart" hub that acts as a DHCP server, make sure that none of the host
computers are configured as DHCP servers.

v If you're using Static IP, check that AudioTron's IP address settings don’t conflict with
another PC or another AudioTron on the network. See the Winipcfg section in the “ Network
Basics’ Appendix for details.

v" I your PC is running “firewall” software, it should be configured to pass AudioTron’s |P
address. Check the software manufacturer’ s instructions on how to set this.

v’ If you're using a LinkSys Etherfast Cable/DSL router, check that the firmware is version 1.37
or higher. Firmware versions lower than 1.37 may have a problem providing DHCP and IP
Address accessto AudioTron if the Linksysis used as a hub for your network.

If you’re using an HPNA network...

v Make sure AudioTron is connected to the same phone line as your HPNA network. Try
hooking up two phones to the jacks you' re using for AudioTron and an HPNA-connected PC.
If you can’t talk on the two phones using the same jacks and cables, then the HPNA network
won't be able to communicate between the PC and AudioTron.

v"If you have DSL service, make sure the DSL line filter is not between AudioTron or your PC's
HPNA interface or it could affect the HPNA network signals and cause performance problems.

v Do not connect a telephone line filter between AudioTron’s HPNA jack and the phone jack.
Transient protection is built into the AudioTron phone jack, so an external filter is not
necessary.

Why do some song titles come up twice in the display?

v Two songs with different file names but the same Title tag information will be displayed as the
same song twice (because the tag information for “Title” is the same.)

v A song with the samettitle saved in different formats (e.g. WMA, MP3 or WAV) will display
in al of the formats as different songs.

v' I, after checking your song library to confirm there’s only one version of the song, try re-
setting AudioTron with the rear-panel power switch. Thiswill reset the internal memory and
cause it to re-scan the network for songs.

v Nested shares can also cause double-occurrences. For instance, if songs are stored in C:\My
Documents\My Music and both the C: drive and \My Music are set as shared directories, the
music filesin \My Music might be displayed twice.

Why doesn’t AudioTron work with my Router/Hub?

Some router/hubs need a firmware update to operate properly with AudioTron:

= SMC Hub: Version 1.8x firmware works with AudioTron using Static IP addressing. It works
intermittently as a DHCP server—sometimes AudioTron finds a host but no host name and it
often cannot find files on shared PCs. The firmware update to 1.90 seems to correct the DHCP
server and file share problems and can be found on the SMC web site: www.smc.com.

= Linksys 4 Port Router/Hub: Version 1.35 firmware works with AudioTron using Static IP
addressing and intermittently as a DHCP server. Sometimes it finds a host but no host name and
it rarely can find files on shared PCs. The firmware update to v1.37 corrects this and is available
on the Linksys website www.Linksys.com.
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Appendix B: Network Basics

Many books have been written about the subject of networking. Therefore, this appendix is only
intended to provide a brief overview of how AudioTron works in a home network environment.

Overview of Home Networks

A Home Network lets you transfer files between PCs, share hardware (e.g. printers, scanners, etc.)
and share an Internet connection among several users. Therate at which datais transferred on the
network is measured in Megabits per second (“Mb/s").

If you don’t have a network, you can set one up with a network starter kit, which typically includes
all of the hardware and software you'll need for a small network. Be sure to get a kit that supports
the Windows Plug and Play (PnP) standard, which makes it alot easier to install the driver
software.

AudioTron is compatible with Ethernet or HPNA (Home Phone Line) network technologies.
Wireless and power line networks are not compatible with AudioTron.

HPNA (Home Phone Network Alliance) Networks

An HPNA network is easy to set up because it uses standard analog phone lines. So in most cases
you won't have to add wiring to your home. There are two versions of HPNA:

HPNA 1.0 transfers data at a maximum rate of 1 Mb/s
HPNA 2.0 operates at rates up to 10 Mb/s.

AudioTron is designed to work with HPNA 2.0, and will not work reliably on HPNA 1.0. Although
HPNA does not require new wiring, it transfers data at a slower rate than Ethernet and the network
components can be more expensive.

An HPNA network does not affect your phone line or Internet connection. Y ou can transfer data on
the network and make phone calls at the same time, even though the network and your phones are
using the same wires. HPNA isincompatible with digital phone lines that are sometimes used with
multi-line phone systems.

Y ou can find out more about HPNA by visiting http://www.hpna.org.

Ethernet Networks

Ethernet is awell established networking standard, so it has awide variety of components that are
relatively inexpensive. Like HPNA, there are two types of Ethernet:

Regular Ethernet (referred to as 10BaseT) runs at 10Mb/s.
Fast Ethernet (referred to as 100BaseTX) runs at 100Mb/s.

AudioTron is compatible with 10BaseT Ethernet and is incompatible with networks that can run
only 100BaseTX Ethernet. Most Ethernet networks will automatically switch between these two
speeds (referred to as “ 10/100BaseT”) so running AudioTron on a 10/100BaseT is not a problem.

A major benefit of Fast Ethernet is that it transfers data at speeds as much as 10 times faster than
HPNA.. Ethernet a so supports sophisticated networked peripheral s, such as network drives,
intelligent switchers, etc., however, it requires special cable (called “CAT-5") and devices called
“Hubs’ for multiple connections. Many computer stores have inexpensive hubs and cables in fixed
lengths with connectors already mounted on each side, making it relatively easy to wire an Ethernet
network in your home.
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Should you install an HPNA or Ethernet Network?

AudioTron (except in the case of WAV file playback.) However, it does improve file transfer speed

3 The increased speed of an Ethernet 10/100BaseT network is not necessary for operating your
between PCs in your network, which can improve network performance.

If you don’t mind setting up your home with special wiring and you want the added benefits of
faster data transfer, then Ethernet is a better choice for networking. If you want to set up a network
quickly and easily, then HPNA will handle most tasks and is compatible with AudioTron.

Setting up either type of network will require a Network Interface Adapter (NIC), which is
available from several manufacturers as cards that install inside your PC, or external adapters that
connect to aUSB (Universal Serial Bus) port.

Network Terminology

TCP/IP Network Protocol

The “language” used to transfer data between devices in a network is called the “ network protocol”
and is referred to with acronyms such as TCP/IP, IPX/SPX and NetBEUI. AudioTron uses TCP/IP
(Transmission Control Protocol/Internet Protocol) to communicate over a network.

If your network isn’t set up using the TCP/IP protocol, AudioTron won’t be able to play music from
the PC hard drives.

. 1 <]
To check if your network is running TCP/IP Corkpraben | arteaton | e Corari|
in Windows 98... Thos bl g stk N il e Wt
=] Chard for Himiceal| Hekeoda
I 0 o L v 4
1. Launch the Control Panel (Start = Settings = Control ;:;‘f“n:';:_"x:“‘”“""““m'
Panel). STER P - Vi B2 bated P Efteses fxtapnes [ V1)
US| e, el vt charing for Hizsanmi! Hakaark
2. Double click on the Network icon to launch the Network o] feor | Feosts |
Dialog. 7
mrwy M bk | ogore
|l.'l-e--l-:-N-'l-:ollH-:-c-l-.: j
3. Inthe Network Dialog, find the listing for your Ethernet or R
B . g
HPNA network interface card (NIC). Make sure it shows :
TCP/IP routed to the NIC and that File Sharing is enabled. e
wade-arsa natraorks

4. If TCP/IP is not installed, refer to the Windows Help for
instructions on how to set up the network with TCP/IP. — —

IP (Internet Protocol) Addresses and Sub-net Mask

AnIP Address isthe number assigned to each device on a network running TCP/IP protocol. A
sub-net mask is used to derive the address of the entire network.

Think of the IP address as a*“phone number” of each device in the network. Within the same area
code, no two people have the same phone number. If two calls are made to the same number at the
sametime, both callers will get abusy signal and no communication can take place. So it iswith IP
Addresses; each computer on a network must have its own unique IP Address (“phone number”)
and the network must have its own area code, which is derived from its Sub-net Mask.

AudioTron is compatible with “Class C” networks, which uses a special type of addressing that is
related to the Sub-net Mask. An explanation of Class-C networking is beyond the scope of this
manual.
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Setting up an IP Address on AudioTron

To avoid conflicts with other devices on the network, AudioTron can be assigned an | P address
that’s about 10 digits higher than the IP address of any other device on the network (keeping in
mind that the last number in the IP address cannot exceed 254.) For example, if you find that the
highest |P address for all of the PCs on your network is 192.168.1.105, then a good address for
your AudioTron would be 192.168.1.115. If you connect a second AudioTron it could use the IP
address 192.168.1.116, athird AudioTron could use 192.168.1.117, and so on. The highest valid
number would be 192.168.1.254.

AudioTron’s “Display Network History” Option can be used to check many of the network settings.
See the “Options Menu” section for details.

DHCP (Dynamic Host Client Protocol) Server

The easiest way for adeviceto get an |P address is to be automatically assigned one by another
computer. Thisis accomplished using a service called DHCP, with one of the computers on the
home network functioning as a"DHCP Server". With DHCP, one of the devices in the network
(the “DHCP Server”) automatically assigns | P addresses to every device on the network, so you
don't have to do it manually.

The most common way to implement DHCP isto configure a PC as a DHCP server for the
network. To do this, you'll have to refer to a networking manual because it’s beyond the scope of
this manual. There are also Cable/DSL Router boxes that can act as DHCP servers.

If you have a Cable/DSL Router installed on your network, you should use only the Cable/DSL
Router box as the DHCP server, not aPC. A network can have only one DCHP server.

Firewalls

A Firewall is specia “security” software that keeps unwanted outsiders from breaking into your
network. Firewalls are primarily used to prevent “hackers’ from accessing your PC hard drive
while you're on the Internet. For example, if you're accessing the Internet from aDSL or Cable
modem which maintains the same |P Address to the outside world, it might make it easier for
hackers to return to the same address until they’ ve figured out away to “break in”.

If a firewall is running on a network PC that contains music for AudioTron, the firewall should be
set to pass the AudioTron’s IP address. Otherwise, it will treat AudioTron as an unauthorized
"user" and prevent it from accessing music files in the PC’s Shared directories. If this is the case,
follow the instructions supplied with your firewall product.

Passwords

AudioTron uses two kinds of passwords. One isfor protecting “shared directories” on Windows
98/Me and the other is used in conjunction with a network running on Windows NT or 2000.

AudioTron can save only one password, so you can only use a single password to protect all your
shared music directories in Windows 98/Me. When password protecting your shared directories, set
the password in the AudioTron Options “ Share Password” setting, as described in the “ Options
Menu” section.

AudioTron also requires a password if your music server isrunning Windows NT or 2000. These
Network Operating Systems treat all devices accessing the PC asa"User". Each user requires a
Username and User Password, so AudioTron will need one as well. User names and passwords are
set in the Windows Network control panel” for the music server PC, and in the Options menu in
AudioTron.

=

Passwords are case sensitive! The password "MYPASS" is a completely different password than
"MyPass" or "mypass". It is usually best to make your passwords with all lower-case letters.
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Checking Windows 98 Network settings with “Winipcfg.exe”

Windows 98 includes a network diagnostic program

called Winipcfg.exe which may be run from the IF Conliguration o=
Windows “ Start” menu (“ Start & Run = Winipcfg”). gl e
This program may be used to find the IP Address, CHA SN 2

Subnet Mask, and other relevant TCP/IP settings for A | BabITOGIECE
each PC on your network so that you can pick e gggﬁ:
appropriate settings for AudioTron. e g, —TIETERTT
When the dialog box appears, click on the “pull down” o 1 mesae | réisw |

menu to select your network interface card (in this case
an Intel 82557-based Ethernet PCI card). Then note the
IP Address, Subnet Mask and default Gateway settings. The |P address setting for AudioTron
should not conflict with the IP addresses for any of the PCs on your network. The Subnet Mask and
Default Gateway settings on AudioTron should match the settings on your network PCs.

Rzinze &1 | Fenessall I Jn_lmehln:-rl

If your network is running a DHCP server, the IP Addresses will be assighed by the server. You
can reassign the | P address by pressing the Release All button, followed by Renew All. Typicaly,
this would be done on each PC when you add a new PC to the network. More information on this
procedure can be found in the Windows Help file, or in a Windows reference manual.

In Windows NT and 2000, the utility IPCONFIG.EXE may be run from the DOS prompt to obtain
the IP configuration settings.
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Appendix C: Network Troubleshooting Procedure

Before following this procedure, please refer to the section called “ Connecting AudioTron to your Network” to
check for the most common network issues.

Run the AudioTron Setup Utility from the
AudioStation CD.

See "Installing the AudioStation CD" for

more details

T

Turn the power off and on.
Press Standby.

When rebooting AudioTron, look at the display messages as it
attempts to log-on to the network.

The display should indicate the type of network you're using

(HPNA or Enet).

What happened?

Displays "No Host Found"

Run the AudioTron Setup
Utility

Scans for songs and
dispays main menu

Found host, but displays
"No Songs Found"

Network connection is
operating. Go back to
Setup procedure.

Directory sharing problem.
See "Song Directory
Troubleshooting
Procedure”

What happened?

Press "Next" to enter the
Network Scan screen

Click to highlight the
network adapter.
Press "Start Test"

T b e ) L e 5 g B P At A 1
ey S e e A

No network adapters were
found

Your network is not set up
properly.

What happened?

AudioTron and PC's are

L . i
:._ _:"‘,___" listed in the Network Nodes
BEE screen
= = - [ =Y _—
e o] b )
Was a DHCP server
detected?

AudioTron is not in the list

See the "Network Basics"
Appendix for network
troubleshooting tips.

What happened?

Yes, there is a DCHP
server.

No DCHP server was
detected.

Return to the Setup
procedure to see if
AudioTron can now log on
to the network.

See "Configuring
AudioTron's Network
Settings" for instructions
on setting up AudioTron
with Static IP Addressing
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If no network adapter is
found, the networking
hardware is either not
installed or not installed

properly.

Please refer to the
network hardware
documentation for
details on how to
properly configure your
network before
proceeding.

Make sure
AudioTron is
powered on.

If it is, check the
network connection
to AudioTron.

If no DHCP server was
detected, AudioTron's
network settings must
be manually configured,
with a Static IP
Address.
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Using the AudioTron Setup Utility

The AudioTron Setup Utility (run from the AudioStation CD) lets you determine if AudioTron is
connected to your network and if PCs on your network contain music accessible to AudioTron.

Opening Screen

The Opening Screen checks the number of network Ml s hsan et

adapters installed on your computer. If no network
adapters were found, the screen indicates that the
test cannot be run. If at least one network adapter is
installed, the screen looks like theillustration:

ABUDTROMN

REEEE R oot el o chagrasscs g, Thi asplcain =
ol i eron 1 e s deies | 1o s rad sy

stz | yors sk b e plerd oo el g e o o e

e catmciad

oot i 4 =104 ot 0y Al T Wt T o 1 (Ol b 0

s bk |l i il g b o vk @ B

Tt bt s vl chach o i i Bl i oo shasdd ik 10l el
Feus b e Bz e oy ol el el v 1em

¥ b s i appbcition an sech machive shich contain medi e
v pos el B o e vty

Y ou can choose to create adetailed LOG file as the
test isrunning (default setting). If the box is not

;:_Tecked, the program creates asimplified LOG Tﬂrjl:’h
ile.

B Crushe s cotaed LG e i e o o

I

Network Test Screen

The top section of the Network Scan screen lists Figure 18: Opening Screen

the network adapters found on your PC, while the
bottom section lists the devices found on the network (PC’s, AudioTrons, Routers, Hubs, and any
other device with an |P address.)

Network Adapters Window

The top section shows the network adapters found
on your PC. The second column indicates if the

adapter was tested. The network adapter types St oo o e oo bk e S T b
include: @i Ama Dag GO0 WD amemzam
e BT Daee. (s PHOF MRRiR AT FEEEED . R
Dialup: Modem or other dialup adapter. (Dial-up
adapters, will be “Skipped” because AudioTron does et Ao B
not connect to a Dialup adapter.) p
Craching rcdic 1521827110
. [y ey —
Static IP: If the TCP/IP property for the adapter has a - il
manually specified IP Address —
DHCP: If the TCP/IP property of the adapter obtains
an automatic IP Address from the server.
T r ey {15k 1. 0 :| B [ ;nﬂ L
Auto IP: It is recommended that you convert this
adapter to use static IP addressing. | =]
The third and fourth columns show the Server's IP Fidure 19: Network Scan S
Address, subnet mask and DHCP settings. igure 2=: Network scan screen

To run a network scan...

1. Click to highlight the HPNA or Ethernet adapter connected to the AudioTron network.

2. Specify the IP range to test by setting the numbers in the IP controls. (It is recommended that you leave
these numbers unchanged so your entire network is tested.) Note that only the forth (the right most) entry in
the IP control is editable. The first three always match the IP Address of the adapter. The minimum range is
0 and the maximum range is 255. On some adapters, the range is any number between these two. The
Default range depends on your adapter and server. If you select a “Dialup” adapter or “Auto IP Server”, then
these controls become read-only and the “Start Test” button is disabled.

3. Click on the “Start Test” to run the network test for the highlighted adapter.

While the test is running, a progress bar shows each node as it is being tested.
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Network Nodes Window
After al the nodes are tested, the bottom window lists the node addresses assigned to peripherals
(e.g. aPC, AudioTron, a print server, hub, router, etc.) The columnsinclude:

Node Address: The address of each node. e

Host name: The name assigned to the PC at the node i . B vt s ko . g i 1 b 4
dd et gy Mo Timind T LI Bograi g [ L
adaress. M T [T LIRS

L L T T TIEND I IR
AudioTron Detected: Set to “Yes” if AudioTron is

detected on the node. Eﬁ?&'&ﬂ&?ﬂmﬁ%ﬂ#ﬁ” o
w3 b I

MAC Address: The network adapter ID on the node.

Note that columns can be sorted by clicking on the Sz memonn
heading. A second click sortsin descending order. SlogEe L
TeiFlicegs [ 1R21H5 7. D :l S (R .“':l o Tt

Shared Directories Test Screen

The Shared Directories Test finds music files that are
accessibleto AudioTron, per the requirements Figure 20: Node list after running test.
described in the Appendix “AudioTron Shared

Directories Requirements”.

e
To scan a PC for Shared Directories... i o e o e i P T

o wec e v e By g i B

1. Inthe Nodes Window, double click the PC Host name T ey g T j
on which to search for shared directories. Or, highlight B :
the PC Host in the list, then click the “Next” button.
(Note: If the PC does not have “File and Print Sharing”
enabled, or does not have any shared folders, an error
message will appear.)

2. Onthe Shared Directories screen, click on the
Configure button to set the drives and file type to
search. (Note: For servers, the “Check Hard Drives” fe
and “Check CD-ROM drives” are disabled.)

3. Press the “Start Test” button, to begin the scan.

After the test is completed, alist of directories with Figure 21: Directories list after running scan.
music filesis displayed, showing:

Paths to the directory il trbaier &g
Dt [ Pk e T Lt B - D T =
Drive type o i s o e prre Trestum.

Number of music files found in the directory

5
q
2
5
g

AT [
Whether or not the files are accessible to AudioTron [ i
(whereby a “No” indicates that the files in the directory R -
are not accessible by AudioTron.) 11_13 o
o Ll
The status bar shows the total number of files found, i TR e
which is sum of the “Files in AudioTron path”, and “Files il L g
not in AudioTron path”. Gaiga. |

For servers, the total number of files is the number of
files found in shared folders, not necessary the number e [ Hwe Casial
of files on the system. In order to get the total number of
files on a server, all the root directories on that server
must be shared.

Figure 22: Viewing the songs in a directory

To sort acolumn, click on the heading.

To view the music filesin adirectory, Double click on a directory nameto list the music filesin
that directory.
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Viewing the Test Results

Clicking the “Next” button on the Directory Scan Screen to view a summary of the test results:

1. The “View Detailed Result” button is shown if the check
box “Create a detailed LOG file as the test is running” is )
checked on the Welcome screen. Click on this button to ) ST
view the detailed results of the errors that occurred while aR s e e
the test was running.

2. The “View Results” will display the normal test results.

3. The “E-mail Results” launches your e-mail application,
and attaches the results of the test to your message.

4. Click on “Finish” to terminate the application.

If the diagnostics did not detect AudioTron speennn] _tetes ) _tewen

on your network... o [REE] O

v' Make sure your network adapter drivers are Figure 23: Test results screen.
installed properly by double-clicking on the
“System” icon from the Windows control panel. Click the “Device Manager” tab. Double click
on “Network Adapters’, then select the adapter AudioTron is connected to from the list and
click on the “Properties’ button. Check the status of your device. If any problems are
displayed, check your adapter documentation on how to fix them.

v Check that your adapter settings are set properly from the network neighborhood by double-
clicking on the “Network” icon from the Windows control panel, select the adapter AudioTron
is connected to, and view its properties. In the “Bindings’ tab, make sure that the TCP/IP
option is checked. If TCP/IP isnot even available, you need to install is. Check your adapter
documentation on how to install TCP/IP for your adapter. Restart your computer if you were
prompted to do so.

v If your network adapter is setup to use a DHCP server, make sure AudioTron is set to use
DHCP. Restart AudioTron if you made any changes.

v'If your network adapter is set to use static | P, disable DHCP setting in AudioTron, and set the

| P address and subnet mask to match those of your adapter. Restart AudioTron if you made
any changes.

If the diagnostic detected AudioTron, but AudioTron can not find your music files...

v

Double click on the “Network” icon in the Windows control panel, click the “File and Print
Sharing...” button, and check the “| want to be able to give others access to my files.” Restart
your computer if you were prompted to do so.

Double click on the “Network” icon in the Windows control panel, click on the
“Identification” tab, give your computer a name and workgroup. Restart your computer if you
were prompted to do so.

Double click on the “Network” icon in the Windows control panel, click on the “ Access
Control” tab, click on “Share-level access control” radio button. Restart your computer if you
were prompted to do so.

If you’re not sure what kind of a server you have, DHCP or static IP

v

v

Check the adapter list in the diagnostics, for each adapter it displays the “type”. The type field
could be one of four types:

Dialup, thisis your modem, AudioTron can hot communicate with this adapter.

Static IP, your adapter isusing static IP. If AudioTron is connected to this adapter, set
AudioTron to use | P address www.xxx.yyy.zzz, and subnet mask aaa.bbb.ccc.ddd.
www.xxX.yyy should be the same as the first three numbers your adapter is using. zzz should
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be a unique number between 2 and 253, the default value in AudioTron is 10. The subnet mask
(asa.bbb.ccc.ddd) is usually 255.255.255.0 for most static | P adapters. Restart AudioTron if
you changed the settings and then run the test again.

v" DHCP, your adapter isusing a DHCP server. If AudioTron is connected to this adapter,
confirm that DHCP mode is enabled in AudioTron options menu. There is no need to assign
any |P address or sunbet mask, your DHCP server assigns these values. Restart AudioTron if
you changed the settings and then run the test again.

v' Auto IP, if AudioTron is connected to this adapter, please check your documentation for
instructions on setting up the DHCP server, or use static | P addressing.

If AudioTron is connected directly to your computer using an Ethernet adapter or an
HPNA card (Win98 and Win ME only)...

v" Make sure TCP/IPisinstalled for your adapter: Double click on the “Network” icon in the
Windows control panel. In the installed network component list box, search for “TCP/IP ->
your adapter name” . |f TCP/IPisnot installed, click on the “Add” button, select “Protocol”,
then click on “Add” again. Select “Microsoft” from the list box on the left and select “ TCP/IP’
from the list on the right. Click the “OK’ button. Restart your computer if you were prompted
to do so.

v' Make sure “Client for Microsoft Networks’ isinstalled: Double click on the “Network” iconin
the Windows control panel. In the installed network component list box, search for “Client for
Microsoft Networks”. If “Client for Microsoft Networks” is not installed, then click on the
“Add” button, select “Client”, then click on “Add” again. Select “Microsoft” from the list box
on the left and select “ Client for Microsoft Networks” from the list box on the right. Click the
“OK’ button. Restart your computer if you were prompted to do so.

v" You need to set up your adapter to use static | P addressing. Double click on the “ Network”
icon in the Windows control panel, then select “ TCP/IP -> your adapter name” component,
and click on “Properties’. In the “IP Address’ tab, select “ Specify an IP address’ radio button,
and type “192.168.0.1" asthe IP address, and “255.255.255.0” as the subnet mask. In the
“Bindings’ tab, make sure “Client for Microsoft Networks’ and “File and printer sharing for
Microsoft Networks” are checked. Click the “OK’ button. Restart your computer if you were
prompted to do so.

v" In AudioTron options menu, disable DHCP, and set the | P address, and subnet mask as
explained above.
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Appendix D: Shared Directories

The directories on your PC’s hard drive can either be “shared” or “not shared”. A “shared”
directory is available to other users in the network, while an un-shared directory is accessible only
on the PC where it resides. By limiting the extent to which other users can access your networked
computer's File System (directories and files), sharing lets you keep your files safe from
unauthorized access and accidental modifications by other users.

To check if your network is set for File
and Printer sharing in Windows 98...

Launch the Control Panel (Start > Settings >
Control Panel). Double click on the Network icon
to launch the Network Dialog.

In the Network Dialog, highlight the listing for your
Ethernet or HPNA network interface card (NIC) and
click on the File and Print Sharing button.

In the dialog box that appears, check the options “I
want to give others access to my files”.

Close all of the dialogs.

To set up a shared directory...

1.

=

In the Windows Explorer directory window, right
click on the directory name and select the “Sharing”
option from the menu. If there is no “Sharing”
option, see the above step to check for File and
Printer Sharing settings in the Network dialog.

From the Share Properties dialog, Select “Shared
As”. The “Share Name” is the name of the sub-
directory you're setting as a “shared directory”.
Your music directories should be under this shared
directory, so they will also be shared.

For “Access Type”, select “Read Only”.

Press “OK” to exit the dialog.
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configured as “shared directories” will be accessible from the remote PC.

You can also run the AudioTron Setup Utility to view shared directories.
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Song Directory Troubleshooting Procedure

Your digital music files must be located in directories called \Music, \Audio or \My Music (with a space in between
"My" and "Music") under a“shared” directory. The AudioStation CD installs sample music files under the proper
directory names, however the share setting must be done manually, as described in the section “ AudioTron Shared
Directories Requirements”. Before proceeding, be sure to install the sample music files and configure the directory

share.

L T e B L g
e sy s

e ﬂ.?-i

T
L

Run the AudioTron Setup
Utility

Double-click "Next" to enter
Scan Directories screen

Press "Start Test" to
search for music files.

-

Double-click on the heading
"Files Accessible to

EETRRENE LR

Cimbir i1 Pty ¥ e i

Lafgstnnm el Muaddbppm T P ss macd s b a0y

AudioTron"

(—

Run the AudioTron Setup Utility from the AudioStation CD.

See "Installing the AudioStation CD" for details

What happened?

A "Yes" in this column indicates music files
in the path can be accessed by AudioTron.

There are paths marked as
"Yes"

No paths marked "Yes"

Double click a "Yes" path to
view the songs

See "Shared Directories"
Appendix to set the proper
directory shares.

What happened?

There are songs in the
paths marked "Yes"

There are no songs in the
paths.

Return to the Setup
procedure to see if
AudioTron plays songs.

Run the AudioTron CD to
load the sample files.
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are no directories
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files on your PC.

AudioTron can only play
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AudioTron Shared Directories Requirements

When AudioTron is booted, it first searches the network for Host PCs. It then searches for music
files(MP3, WMA and WAV) and playlists (M3U and PLS) in directories named \My Music,
\Music, \Audio and \My Documents \My Music that reside under a shared directory.

AudioTron does not search the root shared directory for music and playlist files. Only the properly
named sub-directories under the root are searched. This restriction is imposed in order to
accelerate the search for music files on large hard drives and multiple PCs.

For example, consider the case where drive C: is shared. If AudioTron were to look in the root
share (in this case C) aswell asin every directory below the root share, it would search the entire
hard disk for music files. A large hard disk full of data, including typical installations of Windows,
Microsoft Office and other programs, would take a very long time to search from one end to other.
For this reason, AudioTron ignores the root and instead |ooks for subdirectories with specific
names under the root so that the search time is significantly reduced.

Once it completes the search, AudioTron keeps aloca database of the file namesin itsinternal
memory. That way, it does not have to search the drives each time a song list is requested. If more
songs are added later on, the “ Search for New Music” menu in the Options display can be used to
add only the new file namesto AudioTron’slocal directory, which saves the time of logging all of
the music files it aready knows about. If songs are deleted from the network drives, AudioTron
must be re-booted in order to delete the files from its local database.

In the following examples, AudioTron would find music stored in the shaded directories:

Example 1: AudioTron will not find music in \C because it is not under a shared
e directory. AudioTron will not find music in \AudioTron because it is the
Lli’j root share. AudioTron will not find music in \My Documents because it
AudioTron (Root Share Directory) does not follow the naming convention.
7] My Music
=7 Audio AudipTron will find music in_\AudioTron\My Music, \AudioTrpn\Audio,
; \AudioTron\Music and \AudioTron \My Documents\My Music because
(] Music they follow the naming convention and reside under the shared
? My Documents directory \AudioTron.
My Music

Example 2: AudioTron will not find music in \C because it is not under a shared

directory. AudioTron will not find music in \AudioTron because it is the
root share. AudioTron will not find music in \My Music because it is not
under a shared directory (even though it follows the naming
convention.)

AudioTron (Root Share Directory)
My Music

————{" ] MP3 Music

"] WMA Music

AudioTron will find music in \AudioTron\My Music because it resides
under a shared directory and follows the naming convention.

S — WAV Music

—Ij My Music

AudioTron will find music in \AudioTron\My Music \MP3Music,
\AudioTron\My Music\WMAMusic and \AudioTron \My Music
\WAVMusic because they reside under \My Music.

Example 3:

C (Root Share Directory)
LL(‘:I My Music
{71 Audio
L {7 My Documents

My Music
— MP3 Music
— WMA Music
L ("] WAV Music

L] My Programs

AudioTron will not find music in \C because it is the root share.
AudioTron will not find music in \My Programs or \My Documents
because they do not follow the naming convention.

AudioTron will find music in \My Music, \Audio and \My Documents
\My Music because they follow the naming convention and reside
under a shared directory. AudioTron will find music in all directories
under \My Documents \My Music, even though they do not follow the
naming convention (because they reside under \My Music.)
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Bypassing AudioTron’s Shared Directory Restriction

The Options menu selection “ Search Whole Share” provides away to defeat the “shared
directories’ restriction so that any directory set as a share will be searched for music and playlist
files.

Note that if the shared directories contain alarge number of files, this option could significantly
increase the search time. For this reason, it is suggested that it only be used in cases where
AudioTron cannot find music files even though they are assumed to be in the correct directories.
For best performance, once the files are found, they should be moved to the restricted directories
and the option should be turned off to enable the shared directory restriction.

To bypass the Shared Directory Restriction...

1. Press the Options button and turn the knob to select “Search Whole Share”.
2. Turn and press the knob to select “Yes”.

3. Press the Options button to exit.
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Appendix E: Updating AudioTron’s Firmware

AudioTron contains a microprocessor with two types of memory:

= Random Access Memory (RAM): Used for temporary data storage such as song names,
network settings, Group settings, audio buffers, etc.. This type of memory loses its data when
the main AC power switch isturned off. Thisiswhy, for example, AudioTron has to re-scan the
network for songs each time the rear panel power is turned off.

= FLASH Memory: Used for storage of program data, referred to as “Firmware”. The FLASH
RAM does not lose its data when the main AC power is turned off and can be re-programmed
with new firmware from the Options menu setting called “ Update Flash”, as described below.

Turtle Beach intends to periodically release new updates for the AudioTron firmware in order to
implement feature enhancements, bug fixes, and operational modifications.
To update AudioTron’s firmware...

1. Press the Options button to display the version number of the firmware. The display will look similar to the
following illustration, with the version number shown on the top row:

2.  After checking the firmware version number, log on to the Turtle Beach web site to check for firmware
updates. The URL for AudioTron Firmware & Software Updates is:

http://www.turtle-beach.com/wb/audiotron/download.htm
3.  If the version number posted at the URL is higher than the version nhumber displayed in step 1, download
the file by following the instructions posted at the site. Unzip the file to a subdirectory that contains your
shared music files (e.g. \My Music, \Audio, \Music) so that AudioTron can find the file.

AudioTron firmware files have a .NbO extension and are typically formatted with a name such
as Atronx-xx-xx.nb0, where the “x-xx-xx” represents the version number of the firmware.

4. If the Options LED is not lit, press the Options button. Turn and press the knob to select the “Update
FLASH” option. Turn and press the knob to select “Yes”.

5.  Once AudioTron finds the firmware file, it will transfer the file from your PC to the internal FLASH RAM, as
noted on the display. A successful transfer will display the messages “ERASING”, “PROGRAMMING” and
“VERIFYING”. The new version number will not be displayed until AudioTron is reset, as described below.

= [fthese messages are not displayed, it indicates that AudioTron did not find the firmware file and
the update did not occur. In this case, first check that the firmware file is located in a shared
directory that is accessible to AudioTron (such as a directory with music files that have been known
to operate with AudioTron.) Once the file location is confirmed, try re-setting AudioTron from the
rear-panel power switch to initiate a full network rescan and repeat the update procedure from step
4 above.

6. After the firmware update is successfully completed, reset AudioTron with the rear panel power switch.
Then check if the Version number has been updated from the original setting either by noting the version
number displayed on start-up, or by checking the Options display as described above. Note that the new
version number will not be displayed until AudioTron is reset.

3 Do not turn off AudioTron’s AC power before the firmware download

is completed! Removing the power before the firmware update is completed could
cause the AudioTron “boot loader” to be inadvertently deleted and will render the unit
inoperable. If this occurs, AudioTron will not start up and will require factory service to
reload the firmware.
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Regulatory Compliance Information

For United States users: FCC Part 15

This device has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

. Re-orient or relocate the receiving antenna

. Increase the separation between the equipment and receiver

. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected

. Consult the dealer or an experienced radio/TV technician for help.

Declaration of conformity

Responsible party: Voyetra Turtle Beach, Inc. 5 Odell Plaza, Yonkers, NY 10701 (914) 966-0600 Fax: (914) 966-1102 www.turtle-beach.com
Product: AudioTron Digital Music Player

This device complies with Part 15 of the FCC Rules. Operation of this product is subject to the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Caution
Changes or modifications not expressly approved by Voyetra Turtle Beach could void the FCC compliance and negate your authority to operate the product.
For United States users: FCC part 68

The AudioTron HPNA interface complies with Part 68 of the Federal Communications Commission (FCC) rules. On the HPNA interface card is a label that
contains the FCC registration number and Ringer Equivalence Number (REN) for this device. If requested, this information must be provided to the telephone
company. An FCC-compliant telephone line cord with a modular plug is required for use with this device. The HPNA interface is designed to be connected to the
telephone network or premises wiring using a compatible modular jack which is Part 68-compliant. See installation instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices which may be connected to the telephone line. Excessive RENs on a
telephone line may result in the devices not ringing in response to an incoming call. In most areas, the sum of RENs should not exceed five (5). To be certain of
the number of devices that may be connected to a line, as determined by the total RENs, contact the local telephone company. If this device causes harm to the
telephone network, the telephone company will notify you in advance that temporary discontinuance of service may be required. The telephone company may
request that you disconnect the equipment until the problem is resolved. The telephone company may make changes in its facilities, equipment, operations, or
procedures that could affect the operation of this equipment. If this happens the telephone company will provide advance notice in order for you to make
necessary modifications to maintain uninterrupted service.

Connection of the phone line interface to a party line service is subject to state tariffs. Contact the appropriate state public utility commission, public service
commission or corporation commission for information.

For Canadian users: ICES-003

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the radio interference regulations of Industry
Canada.

Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de Classe B prescrites dans le
réglement sur le brouillage radioélectrique édicté par Industrie Canada.

DOC notice (for products fitted with an IC-compliant modem)

The Industry Canada label identifies certified equipment. This certification means that the equipment meets certain telecommunications network protective,
operation, and safety requirements. The Department does not guarantee the equipment will operate to the users’ satisfaction. Before installing this equipment,
users should make sure that it is permissible to be connected to the facilities of the local telecommunications company. The equipment must also be installed
using an acceptable method of connection. In some cases, the inside wiring associated with a single-line individual service may be extended by means of a
certified connector assembly. The customer should be aware that compliance with the above conditions may not prevent degradation of service in some situations.

Repairs to certified equipment should be made by an authorized Canadian maintenance facility designated by the supplier. Any repairs or alterations made by the
user to this equipment, or equipment malfunctions, may give the telecommunications company cause to request the user to disconnect the equipment. Users
should make sure for their own protection that the electrical ground connections of the power utility, telephone lines, and internal metallic water pie system, if
present, are connected together. This precaution may be particularly important in rural areas. The Ringer Equivalence Number (REN) assigned to each terminal
device provides an indication of the maximum number of terminals allowed to be connected to a telephone interface. The termination on an interface may consist
of any combination of devices subject only to the requirement that the sum of the Ringer Equivalence Numbers of all the devices does not exceed five (5).

Warning!

. To avoid electrical shock or equipment malfunction do not attempt to make electrical ground connections by yourself. Contact the appropriate inspection
authority or an electrician, as appropriate.

. To reduce the risk of fire, use only No. 26 AWG or larger telecommunications line cord.
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